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IMPORTANT NOTICE 

All statements, technical information, and recommendations in this document which relate to the products supplied 
by Meggitt SA are based on information believed to be reliable, but unless otherwise expressly agreed in writing 

with Meggitt SA the accuracy or completeness of such data is not guaranteed. Before using this product, you must 
evaluate it and determine if it is suitable for your intended application. You should also check our website at 

www.meggittsensing.com/energy for any updates to data sheets, Ex certificates, product drawings, user manuals, 
service bulletins and/or other instructions affecting the product. 

Unless otherwise expressly agreed in writing with Meggitt SA, you assume all risks and liability associated with use 
of the product. Meggitt SA takes no responsibility for any statements related to the product which are not contained 

in a current English language Meggitt SA publication, nor for any statements contained in extracts, summaries, 
translations or any other documents not authored and produced by Meggitt SA. 

The certifications and warranties applicable to the products supplied by Meggitt SA are valid only for new products 
purchased directly from Meggitt SA or from an authorised distributor of Meggitt SA. 

Meggitt SA reserves the right to alter any part of this publication without prior notice. 
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PREFACE 
 

About these release notes 

This document provides important information about the VibroSight® software from Meggitt SA. It is applicable to all 
VibroSight-based condition monitoring systems using the versions of software described by this document, namely: 

• VibroSight software version 5.1.0 (CD part number 609-004-000-049). 

This document contains information about changes to the software since the previously released version 
(VibroSight 5.0.x), such as new features and improvements, solved problems and bug fixes, and hardware and 
software compatibility. 

For more general information on the actual software, or the entire condition monitoring system (CMS), refer to the 
following Meggitt SA documentation: 

 VibroSight® software data sheet 
        (Doc. ref. 660-020-005-220A) 

 Getting started with VibroSight® installation guide 
        (Doc. ref. 660-010-006-227A) 

 VibroSight® help 

 VM600 XMV16 / XIO16T extended vibration monitoring card pair data sheet 
        (Doc. ref. 660-020-010-208A) 

 VibroSight application notes and technical notes. 

 

Users who are familiar with VibroSight may also find it useful to refer to the release notes included in earlier 
versions of the software: 

• VibroSight 5.0.0 (Doc. ref. 660-010-013-229A) 

• VibroSight 4.1.0 (Doc. ref. 660-010-013-228A) 

• VibroSight 4.0.0 (Doc. ref. 660-010-013-227A) 

• VibroSight 3.8.0 (Doc. ref. 660-010-013-226A) 

• VibroSight 3.7.0 (Doc. ref. 660-010-013-225A) 

• VibroSight 3.6.0 (Doc. ref. 660-010-013-224A) 

• VibroSight 3.5.0 (Doc. ref. 660-010-013-223A) 

• VibroSight 3.4.0 (Doc. ref. 660-010-013-222A) 

• VibroSight 3.3.0 (Doc. ref. 660-010-013-221A) 

• VibroSight 3.2.0 (Doc. ref. 660-010-013-220A) 

• VibroSight 3.1.0 (Doc. ref. 660-010-013-219A) 
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• VibroSight 3.0.0 (Doc. ref. 660-010-013-218A) 

• VibroSight 2.12.7 (Doc. ref. 660-010-013-217A) 

• VibroSight 2.12.6 (Doc. ref. 660-010-013-216A) 

• VibroSight 2.12.5 (Doc. ref. 660-010-013-215A) 

• VibroSight 2.12.4 (Doc. ref. 660-010-013-214A) 

• VibroSight 2.12.3 (Doc. ref. 660-010-013-213A) 

• VibroSight 2.12.2 (Doc. ref. 660-010-013-212A) 

• VibroSight 2.12.1 (Doc. ref. 660-010-013-211A) 

• VibroSight 2.12.0 (Doc. ref. 660-010-013-210A) 

• VibroSight 2.11.6 (Doc. ref. 660-010-013-209A) 

• VibroSight 2.11.5 (Doc. ref. 660-010-013-208A) 

• VibroSight 2.11.4 (Doc. ref. 660-010-013-207A) 

• VibroSight 2.11.3 (Doc. ref. 660-010-013-206A) 

• VibroSight 2.11.2 (Doc. ref. 660-010-013-205A) 

• VibroSight 2.11.1 (Doc. ref. 660-010-013-204A) 

• VibroSight 2.11.0 (Doc. ref. 660-010-013-203A) 

• VibroSight 2.10.1 (Doc. ref. 660-010-013-201A) 

• VibroSight 2.10.0 (Doc. ref. VIBROSIGHT-RN/E) 

• VibroSight 2.9.7 (Doc. ref. VIBROSIGHT-RN/E) 

• VibroSight 2.9.6 (Doc. ref. VIBROSIGHT-RN/E) 

• VibroSight 2.9.5 (Doc. ref. VIBROSIGHT-RN/E) 

• VibroSight 2.9.4 (Doc. ref. VIBROSIGHT-RN/E) 

• VibroSight 2.9.2 (Doc. ref. VIBROSIGHT-RN/E) 

• VibroSight 2.9.1 (Doc. ref. VIBROSIGHT-RN/E) 

• VibroSight 2.9.0 (Doc. ref. VIBROSIGHT-RN/E). 

 

Structure of the release notes 

This document presents information in the following order: general items first, then in terms of the software 

modules that constitute VibroSight, such as  Configurator,  Event Viewer,  Mimic,  Scope, 

 Server,  System Manager and  Vision. 

You should read those sections that are most relevant to you and then keep the document for future reference. 
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Version identifiers 

A complete VibroSight software version number has four components that provide the following information: 

• x.x.x.x, major release identifier – typically incremented once per year. 

• x.x.x.x, minor release identifier – incremented for each release with typically four scheduled releases per 
year. 

• x.x.x.x, “hotfix” release identifier – 0 for a normally scheduled release and incremented for each hotfix 
release. 

• x.x.x.x, software build number – for internal use. 

For each scheduled release of VibroSight, at least one of the first two digits changes (x.x.x.x). 
For unscheduled “hotfix” releases, which are occasionally required to solve urgent problems, the third digit changes 
(x.x.x.x). 

The version identifiers for installed software appear in the Help About box (obtained using Help > About … in any 
VibroSight software module). 

 

Terminology 

To distinguish between the different Meggitt SA products that can be used with the VibroSight® software, the 
following terminology is used in this document: 

• VM600 card – to refer to the VibroSight-software compatible cards that are installed in a VM600 rack. The 
currently available VM600 cards that are designed for operation with the VibroSight software are the 
XMx16 card pairs (XMC16 / XIO16T, XMV16 / XIO16T and 
XMVS16 / XIO16T) and the CPUx card pairs (CPUR2/IOCR2 and CPUR/IOCR). 

Where XMx16 card is used in this document, it refers to XMC16 / XIO16T, XMV16 / XIO16T and XMVS16 / 
XIO16T cards, unless otherwise stated. 

Where CPUx card is used in this document, it refers to CPUR2/IOCR2 and CPUR/IOCR cards, unless 
otherwise stated. 

• VibroSmart® module or VibroSmart® device – to refer to VibroSight-software compatible modules or devices 
that are used in a distributed monitoring system. The currently available VibroSmart modules and devices 
that are designed for operation with the VibroSight software are the VSI010, VSN010 and VSV30x. 

Where VibroSmart module is used in this document, it refers to the VSI010 and VSV30x modules, unless 
otherwise stated. 

Where VibroSmart device is used in this document, it can refer to the VSN010 device only, or to the VSI010 
and VSV30x modules and the VSN010 device, unless otherwise stated. 
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1 Licensing 

Since VibroSight 4.0.0, the ability to install and run VibroSight software updates and upgrades depends on the 
purchased “Updates and support” package. 

NOTE: VibroSight 5.1.0 is a minor level release and a new license key file is not required 
for updates and upgrades from VibroSight 5.x.x. 

However, a new license key file is required for updates and upgrades from 
VibroSight 3.8.x or earlier. 

 

For further information on licensing or to obtain a new VibroSight license key file, contact Meggitt SA customer 
support. See 7 Customer support. 

 

2 Features 

General 

2.1 Support for the next generation of VM600 machinery protection system (VM600 MPSG2) 

VibroSight 5.1.0 adds further support for the latest version of VM600 machinery protection system, that is, support 
for the second generation (G2) of machinery protection cards, consisting of: 

• MPC4G2 and IOC4G2 machinery protection card pair 

• RLC16G2 relay card. 

 

NOTE: In order to help distinguish between the different VM600 machinery protection 
systems (MPSs), the following distinctions and terminology are used: 

• VM600 MPSG2 refers to the new second generation (G2) of MPS using 
MPC4G2 and IOC4G2 machinery protection card pairs, and the RLC16G2 relay 
card. 
VM600 MPSG2 systems are configured and operated using the VibroSight® 
software, notably VibroSight Protect. 

• VM600 MPS refers to the existing first generation of MPS using 
MPC4 and IOC4T machinery protection card pairs, and the RLC16 relay card. 
VM600 MPS systems are configured and operated using the VM600 MPSx 
software. 

 

VM600 MPSG2 cards, systems and solutions will be officially launched and available later in 2020. 
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VM600 MPSG2 software 

VM600 MPSG2 cards (MPC4G2/IOC4G2 and RLC16G2) and systems are configured, operated and managed 
using the VibroSight software. 

Accordingly, the VibroSight software now includes a new module (client application) dedicated to the configuration 
of VM600 MPSG2 cards/systems, called VibroSight Protect. 

NOTE: The VibroSight Protect software is distinct and separate from 
VibroSight Configurator in order to ensure the segregation of machinery protection 
systems (MPSG2s) and condition monitoring systems (CMSs) when both are 
installed in the same VM600 rack (for example, as required by API 670). 

In this way, MPS and CMS configurations use separate tools with separate output 
configuration files. So it is simply not possible for access and/or changes to a CMS 
(VibroSight Configurator) to interfere in the operation of a MPS (VibroSight Protect) 
in the same VM600 rack, whether by accident or intent.  

 

The other existing VibroSight software modules are used for the operation and management of VM600 MPSG2 
cards in the usual manner. For example, VibroSight Vision is used to display measurements using its extensive plot 
library, VibroSight System Manager is used to update firmware and download log files, and so on. 

 

VM600 MPS software 

For reference, VM600 MPS cards (MPC4/IOC4T and RLC16) and systems are configured, operated and managed 
using the VM600 MPSx software. 

NOTE: The VM600 MPSx software is distinct and separate from VibroSight in order to 
ensure the segregation of machinery protection systems (MPSs) and condition 
monitoring systems (CMSs) when both are installed in the same VM600 rack 
(for example, as required by API 670). 

In this way, MPS and CMS configurations use separate tools with separate output 
configuration files. So it is simply not possible for access and/or changes to a CMS 
(VibroSight) to interfere in the operation of a MPS (VM600 MPSx) in the same 
VM600 rack, whether by accident or intent.  
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The new support added in VibroSight 5.1.0 for VibroSight Protect / VM600 MPSG2 systems includes the 
functionality required to work more quickly, easily and visually with a VM600 rack’s internal buses – the Tacho bus, 
the Raw bus and the Open Collector (OC) bus. 

NOTE: In a VM600 rack, the Tacho bus, the Raw bus and the Open Collector (OC) bus 
allow for the sharing of signals between different cards in the rack, for example, 
between machinery protection system (MPS) cards and/or between machinery 
protection system (MPS) cards and condition monitoring system (CMS) cards.  

 

VibroSight Protect now includes an overall Bus view and individual bus windows that make it easier to configure 
and manage the use of a VM600 rack’s buses. For example, the Bus view and windows make it easier to: 

• See the bus signals/lines used (typically assigned automatically by VibroSight Protect). 

• Change the bus signals/lines used/assigned, if required. 

• See how the jumpers for VM600 MPSG2 cards (MPC4G2/IOC4G2 and RLC16G2) must be configured to 
match the VibroSight Protect configuration for the cards. 

 

Bus view 

In VibroSight Protect, the Bus view for a VM600 rack can be displayed at any time to see how the VM600 rack is 
using its Tacho, Raw and Open Collector (OC) buses. 

To display the Bus view of the VM600 rack in VibroSight Protect, on the Layout tab/page, when the standard view 
is being displayed, click the Bus view icon (top right of main panel). 

 
Figure 1: VibroSight Protect Bus view (rear of rack) 
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Note: The Bus view of the VM600 rack is always displayed from the rear of the rack only. 

 

As shown in Figure 1, the Bus view displays an overall summary view of the VM600 rack buses: 

• Tacho Bus view – Tacho bus, 6 lines, on the second row. 

• Raw Bus view – Raw bus, 64 lines, on the first row. 

• Open Collector (OC) Bus view – OC Bus F to OC Bus A, all 16 lines, on the third to eight rows. 

 

The Bus view in Figure 1 shows a VM600 rack that does not have any MPSG2 cards configured so the Tacho, 
Raw and Open Collector (OC) buses are not yet used. More specifically, the actual buses (circles and horizontal 
lines between cards) are show in grey when the bus is not used/configured and shown in blue when the bus is 
used/configured. 

 

To revert to the standard view of the VM600 rack in VibroSight Protect, on the Layout tab/page, when the Bus view 
is being displayed, click the Bus view icon (top right of main panel). 

 
Figure 2: VibroSight Protect standard view (front of rack) 

 

Note: The standard view of the VM600 rack can be displayed from the front or rear of the rack. The Rotate icon 
(top right of main panel) is used to switch between front and rear views. 
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Individual bus windows – Raw bus, Tacho bus and Open Collector (OC) bus n  

To display more detailed information on the configuration and usage of an individual VM600 rack buses, click one 
of the bus names (left of rack) on the Bus view in order to display an individual bus window: 

• Raw bus 
64 lines 

• Tacho bus 
6 lines 

• OC Bus F 
16 lines 
to 
OC Bus A 
16 lines 

 

The individual bus windows for the Tacho bus, Raw bus and OC Bus n display detailed information on the 
configuration and usage of the individual VM600 rack bus. 

Initially, they show the default bus configuration as determined by VibroSight Protect for the application. They also 
allow the automatically assigned bus configuration to be changed, if required. 

 

 

During the configuration of a VM600 MPSG2 system, VibroSight Protect automatically assigns signals to particular 
lines of a VM600 rack bus, typically by using the next available bus lines that are the most suitable, starting from 
the lowest number. 

The Bus view shows the buses and lines that VibroSight Protect has assigned, if any. 

The Bus view and more specifically, the individual VM600 rack buses therein, allows the bus line(s) automatically 
assigned by VibroSight Protect to be changed, if required. 

 

 

In a VM600 MPSG2 system consisting of a single MPC4G2/IOC4G2 card pair only, with no RLC16G2 card, there is 
typically no requirement for signal sharing. While in a VM600 MPSG2 system consisting of a one or more 
MPC4G2/IOC4G2 card pairs and one or more RLC16G2 cards, there is signal sharing. For example, to control a 
relay on a RLC16G2 card or share signals between MPC4G2/IOC4G2 card pairs. 
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For example, Figure 3 shows the individual bus window for the Raw bus when a MPC4G2/IOC4G2 card pair in rack 
slot 3 is controlling a relay on a RLC16G2 card in slot 4. That is, VibroSight Protect has automatically assigned 
Raw bus line 31 to the RLC16G2 card status signal/line that is monitored by the MPC4G2/IOC4G2 card pair. It has 
also automatically assigned Raw bus line 63 to the VM600 MPSG2 safety signal/line (also known as the “Redline” 
signal) that is driven by the MPC4G2/IOC4G2 card pair. 

 
Figure 3: VibroSight Protect Bus view – Raw bus window 
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For example, Figure 4 shows the individual bus window for the OC bus A when a MPC4G2/IOC4G2 card pair in 
rack slot 3 is controlling a relay on a RLC16G2 card in slot 4. That is, VibroSight Protect has automatically assigned 
OC bus A line 0 to the relay control signal that is driven by the MPC4G2/IOC4G2 card pair. 

 
Figure 4: VibroSight Protect Bus view – OC bus A window 
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Tacho signal sharing 

In VibroSight Protect, an MPC4G2/IOC4G2 card pair can put a tacho signal onto the VM600 rack’s Tacho bus in 
order to share this signal with other card pairs in the same rack. 

To configure a MPC4G2/IOC4G2 card pair tacho signal for sharing on the Tacho bus in VibroSight Protect, on the 
Configure tab/page, select the MPC4G2 card/rack slot from the view of the VM600 rack (top) (or select the card in 
the System window (right))). Then select the Auxiliary n channel used for the tacho, then select the General tab 
(main panel (centre)) and use the Sensor signal sharing control to select the Tacho bus signal/line to use. 

Note: The functionality for an MPC4G2/IOC4G2 card pair to take a tacho signal from the Tacho bus will be added 
in a later version of VibroSight Protect, although the functionality for an XMx16/XIO16T card pair to take a tacho 
signal from the VM600 rack’s Tacho bus exists in the current version of VibroSight Confgurator. 

 

RLC16G2 card 

An optional RLC16G2 card is used with an MPC4G2/IOC4G2 card pair in a VM600 MPSG2 system by assigning 
any of the functionality of the RLC16G2 card to the MPC4G2/IOC4G2 card pair, typically, by configuring the input 
to an RLC16G2 relay to use a logical function output from an MPC4G2/IOC4G2. 

 

When an RLC16G2 card is configured for use by an MPC4G2/IOC4G2 card pair, VibroSight Protect automatically 
assigns two Raw bus signals/lines for use by the VM600 MPSG2 system as follows: 

• VM600 MPSG2 safety signal/line – that is, an MPSG2 system-wide control signal that automatically drives all 
system relays (IOC4G2 and RLC16G2) and analog outputs (IOC4G2) to a safe state should a problem be 
detected. 
Note: The VM600 MPSG2 safety signal/line is also known as the “Redline” signal. 

• RLC16G2 card status signal/line –that is, an RLC16G2 card status signal that combines individual relay and 
power supply monitoring information in a card status information bit that is shared with the controlling 
MPC4G2/IOC4G2 card pair (VM600 MPSG2 system) 

By default, when an RLC16G2 card is associated with an MPC4G2/IOC4G2 card pair, VibroSight Protect 
automatically assigns the two next available Raw bus line(s) that are the most suitable (see Figure 3). 

The Bus view can be used to change these default Raw bus lines if required. 

 

When the input to an RLC16G2 card relay is configured to use a logical function output from an MPC4G2/IOC4G2 
card pair as its input, VibroSight Protect automatically assigns an Open Collector (OC) bus signal/line for use as 
follows: 

• Relay control signal/line – that is, an individual relay control signal that is used to connect the 
MPC4G2/IOC4G2 card pair output and the RLC16G2 card input. 

By default, when an RLC16G2 card relay is configured to use a logical function output from an MPC4G2/IOC4G2 
card pair as its input, VibroSight Protect automatically assigns the next available Open Collector (OC) bus line that 
is the most suitable, that is, from OC Bus A to OC Bus F, depending on the rack slots where the MPC4G2/IOC4G2 
card pair and RLC16G2 card are installed (see Figure 4). 
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The Bus view can be used to automatically route these default Open Collector (OC) bus lines via the Raw bus if 
required. To do this, display the Bus view, then display the relevant OC bus N window, then in the OC bus N 
window, in the Routing column, click Route via Raw bus (see Figure 4). 

Similarly, the Bus view can be used to automatically re-route these default Raw bus lines via the Open Collector 
(OC) bus if required. To do this, display the Bus view, then display the Raw bus window, then in the Raw bus 
window, in the Routing column, click Route via OC bus. 

 

NOTE: On an RLC16G2 card, each relay (RL1 to RL16) is individually confiigurable as 
normally energised (NE) or normally de-energised (NDE), and latched or 
unlatched. 

Each relay (RL1 to RL16) is energised by pulling the relay control signal to ground 
(GND) and de-energised by releasing its relay coil control signal. The activation of 
each relay depends on (1) the individual relay control signal (RL1 to RL16), (2) the 
relay card’s power supply status and (3) the system-wide VM600 MPSG2 safety 
line control signal. That is, each relay is controlled by a relay coil control signal 
which is the logical AND of individual relay control signal, local card power supply 
status and system-wide safety control signal. 

In this way, RLC16G2 card relays configured as NE can always be de-energised in 
the event of a problem with one of the components of the relay coil control signal. 
That is, using the “de-energise to trip principle” required in safety-related 
applications.  

 

 

When two or more MPC4G2/IOC4G2 card pairs are installed in a VM600 rack with an RLC16G2 card, 
VibroSight Protect can be used to configure logical functions on the RLC16G2 card that use logical function outputs 
from the MPC4G2/IOC4G2 card pairs as its inputs. 

This functionality allows status information from multiple MPC4G2/IOC4G2 card pairs in a rack to be logically 
combined and drive a relay on the RLC16G2 card. For example, this can be used to remotely indicate the status of 
the cards in the rack. 
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Jumpers views 

In VibroSight Protect, the Jumpers view for a VM600 MPC4G2/IOC4G2 card pair or an RLC16G2 card can be 
displayed at any time to see how the hardware jumpers for the cards must be configured to match the 
VibroSight Protect configuration for the cards. 

 

NOTE: For a VM600 MPC4G2/IOC4G2 card pair, jumpers on the IOC4G2 card are 
manually configured to select the VM600 rack’s Open Collector (OC) bus and/or 
Raw bus lines that are used to share signals/lines between the MPC4G2/IOC4G2 
card pair and other cards in the rack, for example, to control and monitor RLC16G2 
card relays, to share status information between logical functions, and distribute 
the system-wide VM600 MPSG2 safety line control signal. 

For a VM600 RLC16G2 card, jumpers on the RLC16G2 card are manually 
configured to select the VM600 rack’s Open Collector (OC) bus and/or Raw bus 
lines that are used to share signals/lines between the RLC16G2 card and other 
cards in the rack, for example, to control and monitor RLC16G2 card relays, to 
share status information between logical functions, and distribute the system-wide 
VM600 MPSG2 safety line control signal. 

The jumper information is automatically generated and displayed by the 
VibroSight Protect software. 

 

 

In VibroSight Protect, to display the Jumpers information for an MPC4G2/IOC4G2 card pair, on the Configure 
tab/page, select the card/rack slot from the view of the VM600 rack (top) (or select the card in the System window 
(right))), then select the Jumpers tab (main panel (centre)). 

As shown in Figure 5, the Jumpers location displays a photo of the area of the IOC4G2 card to illustrate where 
the jumpers are physically located on the card, while the Jumpers configuration highlights the jumpers that must 
be installed in order to match the VibroSight Protect configuration. 

NOTE: When configuring hardware jumpers on IOC4G2 and RLC16G2 cards, it is 
important to note that each card can be different and that for each card: 

• Jumpers shown as grey in the Jumpers configuration (VibroSight Protect) for 
the card must be removed (not installed). 

• Jumpers shown as blue in Jumpers configuration (VibroSight Protect) for the 
card must be inserted (installed). 
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Figure 5: VibroSight Protect – jumpers information for an MPC4G2/IOC4G2 card pair 

 

 

In VibroSight Protect, to display the Jumpers information for an RLC16G2 card, on the Configure tab/page, select 
the card/rack slot from the view of the VM600 rack (top) (or select the card in the System window (right))), then 
select the Jumpers tab (main panel (centre)). 

As shown in Figure 6, the Jumpers location displays a photo of the area of the RLC16G2 card to illustrate where 
the jumpers are physically located on the card, while the Jumpers configuration highlights the jumpers that must 
be installed in order to match the VibroSight Protect configuration. 

NOTE: When configuring hardware jumpers on IOC4G2 and RLC16G2 cards, it is 
important to note that each card can be different and that for each card: 

• Jumpers shown as grey in the Jumpers configuration (VibroSight Protect) for 
the card must be removed (not installed). 

• Jumpers shown as blue in Jumpers configuration (VibroSight Protect) for the 
card must be inserted (installed). 
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Figure 6: VibroSight Protect – jumper information for an RLC16G2 card 

 

 

NOTE: VibroSight Protect / VM600 MPSG2 systems must not be used for “live” machinery 
protection system (MPS) applications until these products are officially released. 
Contact Meggitt SA for further information. 
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2.2 VibroSmart VSV30x support for rolling-element bearing analysis 

VibroSight 5.1.0 adds support for rolling-element bearing analysis using data from VibroSmart VSV30x monitoring 
modules – equivalent to the existing support for rolling-element bearing analysis using data from VM600 XMV16 
monitoring cards. 

VibroSight’s support for rolling-element bearing analysis enables early fault detection and diagnosis of rolling-
element bearings using vibration signal analysis with either an advanced demodulation (envelope) signal analysis 
technique and/or simple crest factor measurements. 

NOTE: VibroSight rolling-element bearing analysis can now be used with either  
VibroSmart VSV30x modules or VM600 XMV16 cards. 

VM600 XMV16 support for rolling-element bearing analysis was added in 
VibroSight 4.1.0 (June 2019). 

 

Rolling-element bearings are used in many machines in industry, from small to large. Although well understood and 
designed to last for many years, in practice, less than 10% of all rolling-element bearings reach the expected age 
according to their design parameters. This is often a result of the bearings not being treated correctly, for example, 
due to inadequate lubrication, incorrect installation and/or overload. So ultimately, these bearings are responsible 
for many machinery issues and should be monitored accordingly. 

Inherent to their design, problems with rolling-element bearings are characterised by impacts between the rolling 
elements and imperfections on the race/ring surfaces that result in low-amplitude high-frequency waveforms that 
can be monitored by a suitable condition monitoring system. 

NOTE: Rolling-element bearings produce low-amplitude high-frequency waveforms. The 
high frequencies require that these bearings are monitored using accelerometers. 

 

VibroSight supports rolling-element bearing analysis in one of two ways: 

• Vibration signal analysis with a demodulation (envelope) signal analysis technique 
This is a complex and detailed analysis that uses the existing auxiliary waveform for a dynamic processing 
block in order to generate a dedicated demodulation spectrum, then frequency-specific demodulation data and 
measurements that are related to particular rolling-element bearing defects/failures frequencies. 
Accordingly, demodulation (envelope) signal analysis can detect defects/failures in rolling-element bearings at 
the earliest possible opportunity, thereby allowing maintenance intervals and operational efficiency to be 
optimised. 

• Vibration signal analysis with crest factor measurements 
This is a simple indicative analysis that uses the existing auxiliary waveform for a dynamic processing block in 
order to calculate the crest factor, a measurement that indicates an overall increase in the higher-frequency 
components that are related to general deterioration in a rolling-element bearing. 
Accordingly, crest factor measurements can detect defects/failures in rolling-element bearings that have 
already developed, that is, much later than demodulation (envelope) signal analysis. 
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VibroSight runs both types of rolling-element bearing analysis, separately or simultaneously, at the VibroSight 
Server level. More specifically, for VSV30x modules, it is post-processing performed by the VibroSight Server on 
the data (spectra and waveforms) received from the Asynchronous absolute bearing vibration processing blocks 
configured for the module. 

 

Rolling-element bearing failure frequencies 

Due to their underlying geometry, there are a number of characteristic defect/failure frequencies associated with a 
rolling-element bearing: 

• Ball pass frequency of inner race/ring (BPFI), sometimes also known as Frequency inner race defect (FIRD) 

• Ball pass frequency of outer race/ring (BPFO), sometimes also known as Frequency outer race defect (FORD) 

• Ball spin frequency (BSF), sometimes also known Frequency ball defect (FBD) 
Note: FBD  =  ( BSF × 2 ), as the ball defect hits both the inner and outer races during one rotation. 

• Fundamental train frequency (FTF), sometimes also known Frequency cage (FC). 

 

Rolling-element bearing failure frequencies – formulae 

BPFI  =  RPM × ( NB / 2 ) × ( 1 + ( BD / PD ) ( cos Ø ) ) 

BPFO  =  RPM × ( NB / 2 ) × ( 1 − ( BD / PD ) ( cos Ø ) ) 

BSF  =  ( RPM / 2 ) × ( PD / BD ) × ( 1 − ( ( BD / PD ) ( cos Ø ) )2 ) 

FTF  =  ( RPM / 2 ) × ( 1 − ( BD / PD ) ( cos Ø ) ) 

Where 
RPM is the rotational speed of the bearing (machine) 
NB is the number of balls (rolling elements) 
BD is the ball (rolling element) diameter 
PD is the bearing pitch diameter 
Ø is the contact angle. 

NOTE: These formulae are applicable to rolling-element bearings using ball or cylindrical 
rollers. 

 

So knowing the bearing (machine) speed and the underlying bearing geometry, the expected defect/failure 
frequencies can readily be calculated. It is worth noting that most bearing manufacturers make such information 
freely available on their websites under bearing frequencies (calculator), bearings analysis or similar. 

When these defect/failure frequencies become noticeable in the vibration spectrum, they indicate that there are 
defects within that particular component of the bearing. Further, characteristic spectra (patterns) indicate specific 
defects and problems such as inner race failure, outer race failure, rolling-element failure and train failure. 
Accordingly, these defect/failure frequencies should be monitored in order to support early fault detection and 
diagnosis of rolling-element bearings. 
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NOTE: BPFI is typically 4X to 10X, BPF0 is typically 2X to 7X, BSF is typically 1.5X to 3X. 
and FTF is typically 0.38X to 0.42X, where X is the rotational speed (RPM) of the 
bearing. 

 

 

Crest factor measurements 

As bearing problems develop with the passing of time, the amplitudes of all of the individual characteristic 
defect/failure frequencies associated with a rolling-element bearing gradually increase until they can be detected 
using: 

• Crest factor (CF) – the ratio of the peak value to the effective value of a waveform. 

 

Crest factor measurements – formula 

CF  =  ( | WFPEAK | / WFRMS ) 

Where 
| WFPEAK | is the peak amplitude of the waveform (signal)  
WFRMS is the root mean square (RMS) value of the waveform (signal). 

 

NOTE: Higher crest factor values indicate larger peaks relative to the average energy 
content of the signal. 
For example, a sine wave has a crest factor of 1.414 (√2 ) and a direct current (DC) 
signal has a crest factor of 1. 

 

For a healthy rolling-element bearing, crest factor measurements are initially low as there are no significant peaks 
in the vibration measurement (that is, no impacts between the rolling elements and imperfections on the race 
surfaces). 

As the rolling-element bearing becomes damaged, the crest factor increases as there will be peaks in the vibration 
measurement (that is, due to impacts between the rolling elements and imperfections on the race surfaces). 

As a rolling-element bearing becomes more and more damaged and reaches the end of its life, the crest factor 
then decreases as although there are still peaks, the RMS value of the vibration measurement increases 
significantly. 
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To use rolling-element bearing analysis with VibroSmart VSV30x modules 

• VibroSight Configurator is used to configure the vibration measurement channels of a VibroSmart VSV30x 
module for rolling-element bearing analysis – demodulation (envelope) signal analysis and/or crest factor 
measurements – including any required alarms. 

• The VibroSight Server is used to enable or disable the rolling-element bearing analysis performed by the 
VibroSight Server. 

• VibroSight Vision is used to display and analyse the resultant rolling-element bearing data using the usual 
plots. 

 

 

To configure rolling-element bearing analysis – using demodulation (envelope) signal analysis 

In VibroSight Configurator: 

1. Create a new VibroSight Server configuration containing a VibroSmart VSV30x module (File > New > 
VibroSight Server configuration) or open and modify an existing one (File > Open > … (*.vscfg)). 

2. In the Hardware view, at the VSV30x module node level, under Processing blocks, select an Asynchronous 
absolute bearing vibration processing block. 
The parameters window (centre) updates to display the parameters for the Asynchronous absolute bearing 
vibration processing block. 

3. In the parameters window (centre) for the Asynchronous absolute bearing vibration processing block, 
select the Secondary path tab and under Demodulation spectrum, configure the following parameters: 
Output name: Use the default name for the demodulation spectrum (“My Demodulation Spectrum”) or change 
it, as required. 
Output state: The demodulation spectrum is Disabled by default but must be Enabled when rolling-element 
bearing analysis is required. 
Note: When demodulation (envelope) signal analysis is being used, the Demodulation spectrum must be 
Enabled, the Physical quantity must be configured as Acceleration for the associated Dynamic input channel, 
and the Low pass digital filter Cut off frequency (Main Path) must be greater than the Demodulation spectrum’s 
High pass filter (Secondary path) for the associated Asynchronous absolute bearing vibration processing block. 
Spectrum size: Select 1600, 3200 or 6400 as required. The higher the resolution, the more accurate the 
rolling-element bearing analysis. 
High pass filter: Enter the cutoff frequency for the high-pass filter above which the high-frequency 
defect/failure frequencies for the rolling-element bearing are expected to appear. 
Note: The default frequency is 2 kHz but will depend on the underlying geometry of the rolling-element bearing 
and the speed of the machine. 
Use full display custom values: Select to allow custom minimum and maximum amplitude values and units 
(Max full display and Min full display) to be associated with the demodulation spectrum in VibroSight. 
Min full display: Custom minimum amplitude value and units to be associated with the demodulation spectrum 
in VibroSight. 
Max full display: Custom maximum amplitude value and units to be associated with the demodulation 
spectrum in VibroSight. 
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Note: The update rate used for the demodulation spectrum (Asynchronous absolute bearing vibration 
processing block) and the rolling-element bearing analysis is the same as the update rate configured for the 
VibroSmart VSV30x module at the VSV30x module node level under Standard update rate. 
Note: The default update rate is 1 hour but can be set between 100 ms and 1 m (minute), as required. 

4. In the Hardware view, at the same Asynchronous absolute bearing vibration processing block node level 
used to generate the demodulation spectrum, right-click the Asynchronous absolute bearing vibration 
processing block then click New Secondary path demodulation extraction. 
The parameters window (centre) updates to display the parameters for the Demodulation extraction. 

5. In the parameters window (centre) for the Demodulation extraction (scalar data), under Demodulation 
extraction, configure the following parameters. 
Under Demodulation extraction: 
Name: Use the default name for the demodulation data (“Demodulation Extraction n”) or change it, as required. 
For example, to BPFI, BPFO, etc. 
Extraction state: The demodulation data is Enabled by default but can be Disabled, as required. 
Main frequency: Enter the expected frequency for this defect/failure for the rolling-element bearing. 
Note: The frequency for a particular defect/failure (BPFI, BPFO, etc) is typically available from the bearing 
manufacturer’s website or can be calculated from the bearing (machine) speed and the underlying bearing 
geometry. It is important to note that these frecuencies are not completely accurate due to slip, wear or 
imperfections, and small variations are usually encountered. 
Harmonics: Enter the number of harmonics of the main frequency to be included in the calculation of the 
demodulation data. 
Note: The default number of harmonics is 5. 

Side bands at: Enter the expected frequency for the side bands, if any, associated with this particular 
defect/failure for the rolling-element bearing. 
Note: If there are no sidebands, a value of 0 (zero) should be used. This is the default value. 
Note: Side bands are associated with certain defects/failures, notably BPFI and BSF. 
Side bands: Enter the number of side bands, if any, to be included in the calculation of the demodulation data. 
Qualifier: Select the qualifier (rectifier) to use for the calculation of the demodulation data. 
Under Full display range: 
Use custom values: Select to allow custom minimum and maximum amplitude values and units (Maximum 
value and Minimum value) to be associated with the demodulation data. 
Maximum value: Custom maximum amplitude value and units to be associated with the demodulation data in 
VibroSight. 
Minimum value: Custom minimum amplitude value and units to be associated with the demodulation data in 
VibroSight. 
Under Alarms: 
Allows alarms to be configured for the demodulation data. 

6. In the Data storage view, configure the data logging and event logging (Data logging) of the VibroSight Server 
in the usual way. 
Note: If data logging rules are not configured for the data generated for rolling-element bearing analysis 
(demodulation spectrum and/or demodulation data), then the data will be available as live data only. 

7. Create and activate the VibroSight Server in the usual way (File > Save as > Server / database, then File > 
Apply changes to running configuration). 
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To configure rolling-element bearing analysis – using crest factor measurements  

In VibroSight Configurator: 

1. Create a new VibroSight Server configuration containing a VibroSmart VSV30x module (File > New > 
VibroSight Server configuration) or open and modify an existing one (File > Open > … (*.vscfg)). 

2. In the Hardware view, at the VSV30x module node level, under Processing blocks, select an Asynchronous 
absolute bearing vibration processing block. 
The parameters window (centre) updates to display the parameters for the Asynchronous absolute bearing 
vibration processing block. 

3. In the parameters window (centre) for the Asynchronous absolute bearing vibration processing block, 
select the Secondary path tab and under Demodulation spectrum, configure the following parameters: 
Output name: Use the default name for the demodulation spectrum (“My Demodulation Spectrum”) or change 
it, as required. 
Output state: The demodulation spectrum is Disabled by default but must be Enabled when rolling-element 
bearing analysis is required. 
Note: When demodulation (envelope) signal analysis is being used, the Demodulation spectrum must be 
Enabled, the Physical quantity must be configured as Acceleration for the associated Dynamic input channel, 
and the Low pass digital filter Cut off frequency (Main Path) must be greater than the Demodulation spectrum’s 
High pass filter (Secondary path) for the associated Asynchronous absolute bearing vibration processing block. 

Spectrum size: Select 1600, 3200 or 6400 as required. The higher the resolution, the more accurate the 
rolling-element bearing analysis. 
High pass filter: Enter the cutoff frequency for the high-pass filter above which the high-frequency 
defect/failure frequencies for the rolling-element bearing are expected to appear. 
Note: The default frequency is 2 kHz but will depend on the underlying geometry of the rolling-element bearing 
and the speed of the machine. 
Use full display custom values: Select to allow custom minimum and maximum amplitude values and units 
(Max full display and Min full display) to be associated with the demodulation spectrum in VibroSight. 
Min full display: Custom minimum amplitude value and units to be associated with the demodulation spectrum 
in VibroSight. 
Max full display: Custom maximum amplitude value and units to be associated with the demodulation 
spectrum in VibroSight. 

Note: The update rate used for the demodulation spectrum (Asynchronous absolute bearing vibration 
processing block) and the rolling-element bearing analysis is the same as the update rate configured for the 
VibroSmart VSV30x module at the VSV30x module node level under Standard update rate. 
Note: The default update rate is 1 hour but can be set between 100 ms and 1 m (minute), as required. 

4. In the Hardware view, at the same Asynchronous absolute bearing vibration processing block node level 
used to generate the demodulation spectrum, right-click the Asynchronous absolute bearing vibration 
processing block then click New Secondary path crest factor extraction. 
The parameters window (centre) updates to display the parameters for the Crest factor extraction. 

5. In the parameters window (centre) for the Crest factor extraction (scalar data), under Crest factor extraction, 
configure the following parameters. 
Under Crest factor extraction: 
Name: Use the default name for the crest factor measurement (“Crest Factor Extraction n”) or change it, as 
required. 
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Extraction state: The crest factor measurement is Enabled by default but can be Disabled, as required. 
Under Full display range: 
Use custom values: Select to allow custom minimum and maximum amplitude values and units (Maximum 
value and Minimum value) to be associated with the crest factor measurement. 
Maximum value: Custom maximum amplitude value and units to be associated with the crest factor 
measurement in VibroSight. 
Minimum value: Custom minimum amplitude value and units to be associated with the crest factor 
measurement in VibroSight. 
Under Alarms: 
Allows alarms to be configured for the crest factor measurement. 

6. In the Data storage view, configure the data logging and event logging (Data logging) of the VibroSight Server 
in the usual way. 
Note: If data logging rules are not configured for the data generated for rolling-element bearing analysis 
(demodulation spectrum and/or crest factor data), then the data will be available as live data only. 

7. Create and activate the VibroSight Server in the usual way (File > Save as > Server / database, then File > 
Apply changes to running configuration). 

 

NOTE: Although they use the same underlying waveforms and spectra (for an 
Asynchronous absolute bearing vibration processing block), crest factor 
measurements are completely independent of demodulation (envelope) signal 
analysis. 

 

 

To enable rolling-element bearing analysis (demodulation (envelope) signal analysis and/or crest factor 
measurements) on a VibroSight Server 

In the VibroSight Server user interface: 

1. On the Status tab, under Device drivers, ensure that VibroSmart is enabled. 

2. On the Status tab, under Server features, ensure that Rolling element bearing is enabled. 

3. On the Status tab, under Server features, ensure that Data logging manager is enabled if the VibroSight 
Server is required to log data to its data repository. 

Note: If the VibroSight Server is to be used for the display of live data only, then data logging is not required. 

 

Once a configuration is activated (applied) to the VibroSight Server and the required device drivers and server 
features are enabled, the measurement data becomes available from the VibroSight Server. 
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To display rolling-element bearing analysis (demodulation (envelope) signal analysis and/or crest factor 
measurements) data and measurements in VibroSight Vision 

VibroSight Vision is used to display rolling-element bearing analysis data and measurements in the usual way. 

In VibroSight Vision: 

1. Create a new VibroSight Vision project (File > New project) or open and modify an existing one (File > Open 
> … (*.vsvision)), then select and connect to the VibroSight Server. 

2. Using the Machinery view or Hardware view to select the measurement or measurements to display. 

3. Using the Time Range to select live data or historical data (and the time period of interest for historical data). 

 

 
Application tips and tricks 

Rolling-element bearings produce low-amplitude high-frequency waveforms that should be monitored using 
piezoelectric accelerometers but the amplitude of the high-frequency vibration signals measured by accelerometers 
is highly dependent on the quality of the sensor installation: location and mounting method. So the sensors used for 
rolling-element bearing analysis require careful selection and installation. 

It is not possible to know the level/state of rolling-element bearing damage based on the amplitude of the failing 
frequencies but it is possible based on the defect/failure frequencies. Accordingly, demodulation (envelope) signal 
analysis provides a much wider range of diagnostic capability than crest factor measurements. 
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2.3 VibroSight support for magnetic-flux monitoring and analysis 

VibroSight 5.1.0 improves support for the monitoring of hydro machinery with the addition of magnetic-flux 
monitoring and analysis to the existing ‘Hydro air-gap monitoring’ application specific package. 

(Previously, the Hydro air-gap monitoring package included air-gap monitoring and analysis only – which allowed 
the air gap between rotor and stator, and the rotor and stator shapes (geometrical data) to be monitored for 
hydroelectric generators and other large motors and generators.) 

NOTE: The ‘Hydro air-gap monitoring’ application specific package can be used with 
VM600 XMV16/XMVS16 cards since VibroSight 2.12.0 and/or VibroSmart VSV30x 
modules since VibroSight 3.4.0. 

A new licence key file is required to enable optional packages, such as 
Hydro air-gap monitoring. 

 

Magnetic-flux monitoring involves measuring the magnetic flux density, also known as magnetic field strength, in 
the air gap (that is, the radial distance) between the poles of a rotating rotor inside a stator bore of a hydroelectric 
generator. Magnetic-flux monitoring and analysis can help determine if shorts have occurred in the windings of the 
rotor poles and complements air-gap monitoring to achieve a more comprehensive monitoring solution for larger 
hydroelectric machinery. 

For a generator, magnetic flux is a radial measurement (like air gap) that is detected by means of a magnetic flux 
sensor that is installed on the stator. As each rotor pole sweeps by the magnetic flux sensor, a voltage is induced in 
the sensor that is proportional to the change in magnetic flux from the pole that is passing the probe. Shorted 
windings in the rotor will cause a change in the magnetic flux profile within a pole at a given load. 

In order to monitor the magnetic flux, one magnetic flux sensor (probe) is mounted on the stator, on a horizontal 
plane for a vertical axis machine. 

 

To use the Hydro air-gap monitoring package with magnetic-flux monitoring 

• VibroSight Configurator is used to configure the monitoring system (VM600 XMV16/XMVS16 and/or 
VibroSmart VSV30x) for the magnetic flux sensor/measurement chain being used. 
Contact Meggitt SA for further information on suitable sensors. 

• VibroSight Vision is used to display the resultant magnetic-flux measurements using the existing VibroSight 
Vision plots. 

 

 

To configure the Hydro air-gap monitoring package with magnetic-flux monitoring 

In VibroSight Configurator: 

1. Create a new VibroSight Server configuration containing the appropriate monitoring system (VM600 
XMV16/XMVS16 and/or VibroSmart VSV30x) (File > New > VibroSight Server configuration) or open and 
modify an existing one (File > Open > … (*.vscfg)). 
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2. In the Hardware view, at the VibroSight Server Configuration node level, for example, use aVM600 rack with an 
XMV16 card or a VibroSmart measurement block with a VSV30x modules (as usual). 

3. For the card/module, at the Input channels level, add and configure an input channel as a Tacho input in order 
to generate the 1/rev pulse required for hydro air-gap monitoring. 

NOTE: Although hydro air-gap monitoring can be used without a tacho (1/rev pulse) (for 
example, to get an overview of a hydroelectric generator), it is required in order to 
identify the individual rotor poles. 

 

4. For the card/module, at the Input channels level, add and configure a Dynamic input channel to interface with 
the magnetic flux sensor/measurement chain being used. 

NOTE: A Dynamic input channel used for Hydro magnetic-flux monitoring must be 
configured as follows: 
Physical Quantity: Magnetic flux (unit: tesla (T)) or Magnetic flux variation 
(unit: tesla per second (T/s)). 
Coupling: AC. 
Sensitivity: As required (depends on the Signal Transmission Mode and the 
magnetic flux sensor/measurement chain being used). 

 

5. For the card/module, at the processing blocks level, add and configure a dynamic processing block in order to 
generate the waveforms that the Air gap and flux processing block (VibroSight Server) requires. 

For a VM600 XMV16/XMVS16 card, a Dynamic processing block must be configured as follows: 
Input channel: Select the Dynamic input channel used for magnetic flux measurement. 
Sampling Mode: Order Tracked is recommended (Fixed Frequency can also be used). 
Reference speed: Select the associated ‘hydro’ Tacho input channel. 

For a VibroSmart VSV30x module, a Shaft relative vibration processing block must be configured as follows: 
Input channel: Select the Dynamic input channel used for magnetic flux measurement. 
Reference speed: Select the associated ‘hydro’ Tacho input channel. 
 

NOTE: All channels/processing blocks used for hydro air-gap monitoring, that is, air gap 
and/or magnetic flux, must use the same reference speed (tacho – 1/rev pulse) in 
order to ensure the correct identification of rotor poles and the synchronisation of 
measurements. 

 

 

VibroSight implements the Hydro air-gap monitoring package at the VibroSight Server level, that is, it is post-
processing performed by the VibroSight Server on the waveforms received from the dynamic processing block 
used by the card/module (that is, the principal mode waveform from the Dynamic processing block used by a 
VM600 XMV16/XMVS16 or the waveform from the Shaft relative vibration processing block used by a VibroSmart 
VSV30x). 
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6. In the Hardware view, at the VibroSight Server node level, add a new Air gap and flux processing block to 
configure the hydro air-gap and magnetic-flux monitoring for the application. 
(Note: The Air gap and flux processing block was previously known as the Air-gap processing block.) 

For air-gap monitoring, three layers (Top, Middle and Bottom) are created by default, corresponding to planes 
perpendicular to the rotor axis, which allows for up to three layers of stator air-gap sensors to be defined for air-
gap processing. However, smaller machines typically require only one layer so unrequired layers can be 
deleted (for example, cases histories show that the upper layer on a generator is the most important for 
detecting rubs). 

For magnetic-flux monitoring, the three layers can be ignored, as only a single magnetic-flux sensor is required 
per Air gap and flux processing block (that is, per machine). 

7. At the VibroSight Server’s Air gap and flux processing block level, configure the basic parameters for the 
machine in order to allow the Air-gap and flux processing block to understand the waveform signals and 
generate the hydro air-gap and magnetic-flux measurement data. 

NOTE: The Air gap and flux processing block should be configured as follows: 
Poles: The number of poles on the rotor of the machine. 
(Pole pairs is updated automatically depending on the poles.) 
Line frequency: The utility (mains power line) frequency of the machine. 
(Nominal speed is updated automatically depending on the poles and line 
frequency.) 
Maximum airgap: The maximum expected distance between the rotor and stator. 
Nominal airgap: The typical expected distance between the rotor and stator. 
Note: The Maximum and Nominal airgap values are used by VibroSight software to 
calculate the ‘threshold’ values used for pole detection. 
Numbering direction: The individual rotor poles are automatically numbered – 
after the 1/rev pulse – starting from 1 and increasing in the specified direction 
(viewing the machine from above and independently of the direction of rotation of 
the machine). 
Angle ref to notch (CW): By default, the 1/rev pulse produced by the timing 
reference mark on the rotor shaft and monitored by the associated Tacho input 
channel is located halfway between the first and the last poles. This parameter can 
be changed if a different pole numbering scheme is required. 
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8. For magnetic-flux monitoring, at the VibroSight Server’s Air gap and flux processing block level, add the 
magnetic flux sensor (probe) by right-clicking then clicking New flux probe. Then configure the flux probe. 

NOTE: The Probe must be configured as follows: 
Name: Use the default name for the probe (“Flux probe 1”) or change it, as 
required. 
State: The probe is Enabled by default but can be disable if required. 
Input channel: Select the Dynamic input channel used for magnetic flux 
measurement. 
Input waveform: Select the associated waveform used for magnetic flux 
measurement. 

 

9. For magnetic-flux monitoring, under the VibroSight Server’s Air gap and flux processing block level, for the flux 
probe, configure the individual probe measurements available under the sensor (Flux Probe 1): Flux shape, 
Flux signature, Flux Pn, Min flux, Max flux, Avg flux, THD. 

Full display range is available for all measurements but alarms can only be configured for “extracted” 
measurements (that is, alarms are not available for the Flux shape or Flux signature). 

 

10. For magnetic-flux monitoring, under the VibroSight Server’s Air gap and flux processing block level, for the flux 
probe, configure the layer measurements available under each of the planes used (Top, Middle and Bottom): 
Layer gap-flux corr coef, Layer max corr distance. 

Full display range and alarms are available for all measurements. 

 

11. For air-gap monitoring, under the VibroSight Server’s Air gap and flux processing block level, for each Layer, 
configure each of the stator sensors (Probe 1 to Probe n). 

NOTE: Each Probe must be configured as follows: 
Input channel: Select the associated Dynamic input channel for the stator sensor. 
Input waveform: Select the associated waveform from the Shaft relative vibration 
processing block used by a VSV30x module that corresponds to the input channel. 
Sensor thickness: The combined thickness of the sensor and any glue used to 
install it on the surface of the stator (that is, the distance between the surface of the 
stator and the surface of the sensor facing the rotor). 

For example, an LS120 air-gap sensor has a thickness of 3.8 mm ±0.2  mm. 
Glue thickness depends on the particular adhesive used and the installation. 

 

12. For air-gap monitoring, under the VibroSight Server’s Air gap and flux processing block level, for each Layer, 
configure the individual probe measurements available under each of the stator sensors (Probe 1 to Probe n): 
Rotor shape, Rotor signature, Gap Pn, Min gap, Avg gap, Rotor eccentricity, Rotor ellipticity, Rotor circularity. 

Full display range is available for all measurements but alarms can only be configured for “extracted” 
measurements (that is, alarms are not available for the Rotor shape or Rotor signature). 
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13. For air-gap monitoring, under the VibroSight Server’s Air gap and flux processing block level, for each Layer, 
configure the layer measurements available under each of the planes used (Top, Middle and Bottom): 
Layer rotor signature, Layer gap Pn, Layer min gap, Layer avg gap, Layer rotor eccentricity, 
Layer rotor ellipticity, Layer rotor circularity, Layer rotor shape, Layer stator eccentricity, Layer stator ellipticity, 
Layer stator circularity. 

Full display range is available for all measurements but alarms can only be configured for “extracted” 
measurements (that is, alarms are not available for the Layer rotor shape or Layer rotor signature). 

 
 
The VibroSight Hydro air-gap monitoring package requires that the air-gap and magnetic-flux measurements are 
added to a Shaft node in the Machinery view, so that the direction of rotation of the hydroelectric generator can be 
configured. (If the direction of rotation is not available, the air-gap and magnetic-flux measurements that require the 
direction of rotation in order to be calculated are flagged as bad quality and populated with zero values.) 

 
14. In the Machinery view, at the VibroSight server configuration node level, add a new Machine (under a 

Machine unit and/or under a Facility unit, as required). 

15. At the Machine node level, configure the Global parameters for the hydroelectric generator’s shaft. 

NOTE: The Direction of rotation can be configured in one of two ways: 
Predefined: Allows the direction of rotation to be permanently configured as either 
Clockwise, Counter Clockwise or Clockwise and Counter Clockwise. 
Input Driven: Allows the direction of rotation to be configured as a function of an 
external system input. 

 
16. At the Machine node level, add a new Air-gap measurements node. 

17. At the Air-gap measurements node level, use the Point control to select the VibroSight Server’s Air gap and 
flux processing block level configured in the Hardware view as the input. 

 

 

The configuration is now complete but must be saved as a ‘server / database’ before it can be used. The 
VibroSight configuration is saved and activated as usual. 

Since VibroSight implements the Hydro air-gap monitoring package as post-processing at the VibroSight Server 
level (that is, the VibroSight Server’s Air gap and flux processing), once the VibroSight Server is running, the 
required processing (Server feature) must be enabled: 

 

For the VibroSight Server: 

• On the Status tab, under Device drivers, ensure that the monitoring system (VM600 and/or VibroSmart is 
enabled. 

• On the Status tab, under Server features, ensure that Air-gap is enabled. 
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To display hydro air-gap monitoring measurements using VibroSight Vision: 

VibroSight Vision is used to display the measurement data in the usual way: 

• Using the Machinery view or Hardware view to select the measurement or measurements to display. 

• Using the Time Range to select historical or live data (and the time period of interest for historical data). 

 

The usual VibroSight Vision plot types are used to display hydro air-gap and magnetic-flux monitoring 
measurements. For example: 

• Bar Chart plots, Bode plots, Table plots and Trend plots can be used to display scalar “pole data” such as 
gaps and circularities, and vector “pole data” such as eccentricities and ellipticities. 

Typically, Bar Chart plots, Bode plots, Table plots and Trend plots display Airgap (amplitude) and additional 
pole information is automatically included in the plot legend. 

• Waveform plots can be used to display “waveform” and “rotor data” such as rotor shapes, rotor signatures, 
layer rotor signatures and layer stator shapes. For “rotor data”, a constructed waveform is displayed where 
every pole is a constant amplitude value (the value measured for that pole). 

The Waveform plot’s x-axis can be configured as Time, Revolutions or Poles, as required, and additional gap 
information is automatically included in the plot legend. 

• Polar Waveform plots can be used to display “waveform” and “rotor data” such as rotor shapes, rotor 
signatures, layer rotor signatures and layer stator shapes. For “rotor data”, a constructed waveform is 
displayed where every pole is a constant amplitude value (the value measured for that pole). 

When displaying any gap related curve, the amplitude axis is automatically reversed so that the amplitude 
decreases radially going from the centre of the plot outwards. A gap related curve is plotted as a best-fit 
circle with a corresponding centre marker: “+” for rotor-related curves and “x” for stator-related curves. The 
centre marker and the curve will be the same colour. 

The Polar Waveform plot’s x-axis can be configured as Angle or Poles, as required, and additional gap, 
circularity, eccentricity and ellipticity automatically included is included in the plot legend. 
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VM600 cards 

2.4 MPC4G2/IOC4G2: development and evaluation 

Updated MPC4G2/IOC4G2 card pair firmware intended to support the ongoing development and evaluation of the 
next generation of VM600 machinery protection system (VM600 MPSG2). 

See 2.1 Support for the next generation of VM600 machinery protection system (VM600 MPSG2), and 
5.2.1 Card firmware. 

NOTE: VibroSight Protect / VM600 MPSG2 systems must not be used for “live” machinery 
protection system (MPS) applications until these products are officially released. 
Contact Meggitt SA for further information. 

 

 

VibroSmart modules 

2.5 VSV30x/VSB300: hydro air-gap and magnetic-flux monitoring 

Updated VSV30x/VSB300 module and terminal base firmware that improves support for hydro air-gap and 
magnetic-flux monitoring with a minor bug fix. 

See 2.3 VibroSight support for magnetic-flux monitoring and analysis, and 5.3.1 Module firmware. 
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3 Solved problems and bug fixes 

3.1 General improvements and bug fixes 

General stability improvements and bug fixes across the VibroSight 5.1.0 software. 

 

3.2 Problems with spectra polarity in Full Spectrum plots 

When displaying Full Spectrum plots in VibroSight Vision, spectra amplitudes were displayed correctly but the sign 
of the spectra amplitudes could be displayed incorrectly for certain configurations. More specifically, depending on 
the relative sensor orientations and the shaft’s sense of rotation, the order of the dual shaft relative processing 
could be incorrect, resulting in incorrect spectra polarity. 

Note: A workaround was previously available for this bug that involved changing the order of the probes/channels 
in the dual shaft relative processing block such that the first channel seen by the system (that is, the first “pass by” 
depending on sensor orientation and shaft rotation) was first in the processing block (that is, X Channel Setup 
(on left)). 

 

3.3 Problems with missing poles in Trend plots for hydro air-gap monitoring applications 

When displaying Trend plots in VibroSight Vision for hydro air-gap monitoring applications using VibroSmart® 
VSV30x monitoring modules, poles could be missing from the plot, depending on the speed of the tacho. 

 

3.4 Time slider controls not displayed in plots on some computers 

When displaying plots such as Waveform plots that include time slider controls in VibroSight Vision, the time slider 
controls were not being displayed on some computers. This issue was reported mostly for Windows 10 computers. 

The issue has been traced to the computer’s display settings in general and display scaling settings in particular 
that are too low. On all of the Windows 10 computers tested, a display scaling setting/size of 125% or higher 
eliminated the problem. 

For example: Windows 10 > Display settings > Scale and layout – Scaling 125%. 
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4 Known issues 

4.1 Display of timestamps in VibroSight Vision 

In VibroSight Vision, when the timestamps (date and time) are configured to be displayed as Site time or Local 
computer time and the site time or local computer time is subsequently changed on the relevant computer (for 
example, using Windows > Control Panel > Date and Time), this change is not reflected in the VibroSight Vision 
user interface until the user clicks on the Timestamp displayed in the VibroSight Vision status bar. 

 

 

4.2 VibroSight Server and Host Service restart required after changes to network adapter 

If the configuration of a network adapter is changed (for example, enabled or disabled, connected or disconnected) 
on a computer running VibroSight, then the VibroSight Servers and Host Services running on the computer must 
be restarted in order for the network adapter to be recognized by the VibroSight discovery mechanism. 

 

 

4.3 Length limitation of VibroSight Server instance names 

Since VibroSight 2.9.6, VibroSight Server instance names are limited to 18 characters, whereas up to 
27 characters were allowed in previous versions. This constraint is enforced during the creation of new server 
instances with VibroSight 2.9.6 or later. 

NOTE: VibroSight allows only alphanumeric characters (A to Z, a to z, 0 to 9), the 
hyphen-minus character ( - ) and the underscore character ( _ ) to be used for 
VibroSight Server names. 

 

However, existing server instances may be non-compliant (too long) and no longer run after an upgrade of the 
VibroSight software. In such cases, the file names used for a VibroSight Server database file (*.vssrvdb or 
*.db) and a VibroSight Server configuration file (*.vssrvcfg or *.config) should be updated (and manually 
edited in the VibroSight configuration file) to be 18 characters or less. Changes may also be required in any 
VibroSight software that references the server instance name, such as VibroSight Vision projects. 

Where used, the automated data management commands and operations that append a timestamp 
(_yyyyMMddHHmmss) to the Server instance name reduces the number of file name characters that remain 
available for VibroSight Server instance names to three. Alternatively, the server instance name can be shorted 
after the data repository command or operation is complete. 

Also, depending on the VibroSight Server data repository (database) file names used and any truncation performed 
by VibroSight, it is possible that servers are created with names that contain non-allowed characters (such as 
spaces), with the result that these servers will not be accessible by VibroSight software clients. Similarly, duplicate 
VibroSight Server names are also possible. 
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NOTE: Choose appropriate VibroSight Server names in order to avoid name conflicts 
arising due to truncation and/or additional data repositories being created during 
automatic data management. 

This is particularly important for systems with automated data management and 
system backup procedures that can generate VibroSight Server data repositories 
with different file names. 

 
 

4.4 Display of timestamps in VibroSight clients other than VibroSight Vision 

Although VibroSight Vision now supports the display of timestamps (date and time) as either Site time, UTC time or 
Local computer time, all other VibroSight client software modules continue to display timestamps in local computer 
time only (that is, the date and time according to the local clock of the computer running the VibroSight software 
module). 

 
 

4.5 Display of devices in VibroSight System Manager 

In the System Explorer window of VibroSight System Manager, the Devices tree-view does not always update 
correctly to show all of the devices (VM600 cards and VibroSmart devices) available on the network. 

In particular, this has been seen when changing the firmware of a device, and can persist even after a refresh 
(using the Refresh toolbar button or View > Refresh). 

If this behaviour is seen, the recommended workaround is to: 

• Wait a few minutes and refresh again. 

• Restart VibroSight System Manager. 

 
 

4.6 VibroSight Mimic backwards compatibility 

VibroSight 2.10.0 contained significant improvements and changes, including a separate VibroSight Mimic client 
software module for mimics (that were previously available in VibroSight Vision). As a result, VibroSight Vision 
mimics created with VibroSight 2.9.7 or earlier are not compatible with VibroSight 2.10.0 or later. 

VibroSight 2.11.0 contained significant improvements and changes to the VibroSight Mimic client software module. 
As a result, VibroSight Vision mimics created with VibroSight 2.10.1 or earlier are not compatible with VibroSight 
2.11.0 or later. 

VibroSight 2.11.5 contained significant improvements to the VibroSight Mimic project framework to include version 
information, in order to improve the compatibility between projects created with different versions of VibroSight 
Mimic and eliminate the requirement for the recreation of Mimics. Starting with VibroSight 2.11.5, Mimic projects 
automatically detect any changes in the VibroSight Mimic software that affect project compatibility, inform the user 
and update the project as required. 
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NOTE: VibroSight 2.11.5 is also able to open and work with Mimic projects created with 
VibroSight 2.11.0 or later, if the corresponding database had been updated as 
required. 

 

NOTE: When updating existing machinery monitoring projects created with 
VibroSight 2.12.x to VibroSight 3.x.x or later, a new data repository created by 
copying a VibroSight database (*.vssrvdb) to a VibroSight historical data folder 
(*.vshdf) must use the same server file name as the existing server in order for 
existing VibroSight Mimics to maintain links with the data repository and continue to 
work (without manual corrections). 
In addition, the VibroSight Server using the new data repository must be running 
before the existing VibroSight Mimics are run for the first time, after the update. 

 
 

4.7 VibroSight OPC Clients not recovering 

When a VibroSight OPC Client is being used to import information from an external OPC server into a VibroSight 
system and the external OPC server becomes unavailable, the VibroSight OPC Client may not always recover 
automatically when the OPC server becomes available again. 

This is typically characterised by the VibroSight OPC Client continuing to show connection error messages even 
when OPC server is available and can result in permanent loss of the imported data if not noticed. 

NOTE: The external OPC data can be permanently lost if it is not imported into VibroSight 
as expected. 

Any VibroSight system feature or configuration element relying on the imported 
OPC data will not behave as expected, for example, alarms, machinery operating 
conditions and data logging rules. 

 

If this behaviour is seen, the recommended workaround is to: 

• Stop and restart the VibroSight OPC Client from either the VibroSight Server 
(Data > Acquisition > OPC Device Driver) or VibroSight System Manager. 

• Stop and restart the VibroSight Server, if required. 

 
 

4.8 Duplicate events 

For VibroSight systems using VM600 XMx16 cards, VibroSight Event Viewer retrieves all of the event information 
available from the data buffers on the cards. 

For VibroSight systems using VibroSmart modules, VibroSight Event Viewer retrieves the event information 
available from the current time only (no buffered events). 
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Accordingly, for a VibroSight system using VM600 XMx16 cards, there is the possibility of duplicate events being 
listed in the Event Viewer, particularly for VibroSight systems being operated without an NTP server (where events 
are not recognised as duplicates due to time drift). 

 
 

4.9 VibroSight Server status indicators 

The status indicators (performance counter monitors) on the Status tab of the new VibroSight Server are not 
correctly displayed and updated when an NVIDIA WMI driver is installed on the same computer as the VibroSight 
Server. 

NOTE: The NVIDIA Enterprise Management Toolkit (NVWMI) is a graphics and display 
management and control technology that interfaces to Microsoft’s Windows 
Management Instrumentation (WMI) infrastructure, specific to NVIDIA graphics 
processing units (GPUs). 

 
This is because NVIDIA WMI prevents the Microsoft .NET Framework from obtaining the required counter values 
from the underlying operating system / computer. 

 
 

4.10 XMx16 card pre-logging 

For an XMx16 card pair, if Dynamic Input Channel 16 is used as an input to a Dynamic Processing Block that is 
used as an input to a Dual Shaft Relative Processing Block which is configured to provide an Orbit and/or Full 
Spectrum output, then any pre-logging configured for the principal mode Waveform and/or Spectrum of Dynamic 
Input Channel 16 will not actually log any of the data from the same pre-logging scope. 

 
 

4.11 Problems creating new VibroSight OPC Classic Servers 

Users who have upgraded from an earlier version of VibroSight to a later version (for example, from 
VibroSight 2.x.x or 3.0.0 to VibroSight 3.1.0) can experience problems when creating new VibroSight OPC Classic 
Servers. 

Such problems are typically characterised by the OPC Server Create command in VibroSight System Manager 
displaying an error message such as 
“The type initializer for ‘ch.VibroMeter.Xms.OpcServer.Utils.OpcServerUtils’ threw an 
exception”. 

This typically occurs because an earlier version of the OpcServer.config file required by VibroSight OPC 
Classic Servers is being used by the later installation of VibroSight, which can happen in one of two ways: 

• When a version of VibroSight 3.x.x or later is installed on a computer that was running a version of 
VibroSight 2.x.x or earlier, the VibroSight installer automatically checks existing VibroSight folders (such as 
C:\ProgramData\Meggitt\VibroSight 2) in order to copy relevant system and/or user preference files across to 
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the new VibroSight folders (such as C:\ProgramData\Meggitt\VibroSight), including an earlier 
OpcServer.config file. 

• When VibroSight 3.1.0 is installed on a computer that was running VibroSight 3.0.0, the creation of a 
VibroSight OPC Classic installer using VibroSight 3.0.0 automatically created an earlier OpcServer.config 
file. 

As shown below, the first few lines of a typical OpcServer.config file contains version specific information that is 
incompatible with later versions of VibroSight: 

<?xml version="1.0" encoding="utf-8"?> 

<configuration> 

  <configSections> 

    <section name="opcServersConfiguration" 

type="ch.VibroMeter.Xms.OpcServer.Utils.OpcServersSystemConfiguration, XmsOpcServerUtils, 

Version=2.0.0.0, Culture=neutral, PublicKeyToken=2db2a2387bac0a0a" /> 

  </configSections> 

… 

</configuration> 

 

So for users who have upgraded from an earlier version of VibroSight to a later version, if problems are 
experienced when creating new VibroSight OPC Classic Servers, the workaround is to: 

 

1. Use an XML-compatible text editor program to edit the OpcServer.config file and remove the version specific 
information. That is, change the line containing the section name 
from: 

<section name="opcServersConfiguration" 

type="ch.VibroMeter.Xms.OpcServer.Utils.OpcServersSystemConfiguration, XmsOpcServerUtils, 

Version=2.0.0.0, Culture=neutral, PublicKeyToken=2db2a2387bac0a0a" /> 

to: 

<section name="opcServersConfiguration" 

type="ch.VibroMeter.Xms.OpcServer.Utils.OpcServersSystemConfiguration, XmsOpcServerUtils, 

Culture=neutral, PublicKeyToken=2db2a2387bac0a0a" /> 

 

2. Restart the computer. 
    Note: The computer must be restarted to ensure that the edited version of the OpcServer.config 
    file is used (and not some other version from cache memory). 

 

3. Use the OPC Server Create command in VibroSight System as required. 
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NOTE: The manual migration of existing VibroSight OPC Classic Servers to 
VibroSight 3.x.x or later is described in detail in the “VibroSight OPC Classic Server 

migration” section of the latest  Getting started with VibroSight installation 
guide. 

 

 

4.12 Potential TCP port 50000 conflict 

The VibroSight Host Service (XmsHostService.exe) requires TCP port 50000 for communication with the 
VibroSight software. So if the computer running the VibroSight software is running other software which also 
requires TCP port 50000, this results in a TCP port conflict which can prevent VibroSight (or the other software) 
from running. 

During the VibroSight software installation process, the VibroSight 3.4.x or later installer will typically detect other 
software on the computer that is using TCP port 50000 and report this. For example: “The port 50000 cannot be 
used. Please close all application using this port before manually starting the host service.” 

Accordingly, any potential TCP port 50000 conflicts should be resolved before the VibroSight software can be 
successfully installed and run. 

 

 

4.13 Problems using shared network drives/locations for VibroSight data management 

On computers running Windows 10 or Windows Server 2016, problems can be experienced using shared network 
drives/locations with VibroSight’s integrated data management operations such as Offline data storage and 
Database backup (configured in VibroSight Configurator) due to Windows security policies and restrictions. 

Such problems are typically characterised by the individual copy commands scheduled and run on a VibroSight 
Server (corresponding to Offline data storage and Database backup operations) failing to run correctly. More 
specifically, on the Data Management tab of a VibroSight Server, scheduled incremental copy jobs (Type: Copy) 
are typically displayed with Status: Error, while the Log Messages tab of the server display typically displays 
messages such as “Errors during the copy operation” and “Uncaught error IOException 
occurred in task ‘Task “DataRepositoryCopyDataMan…”. 

NOTE: For Windows 10 and Windows Server 2016, Microsoft improved network security 
with a change to the rules governing shared network drives/locations. 
More specifically, a shared network drive/location is now only accessible and 
visible to the user who created the shared network drive/location, even if the user is 
an Administrator. 

 

Accordingly, in order to avoid such problems, a shared network drive/location on Windows 10 and 
Windows Server 2016 computers that is required to be used by VibroSight’s integrated data management 
operations should be created as a “system account” in order to ensure that the required Windows Services can 
access the shared resource (drive/location). 
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This can easily be done using Microsoft’s PsExec utility. For example, by running the following command (as an 
Administrator): 

PsExec.exe -i -s cmd.exe /C "net use Z: \\server\share"  

Where the net use command is used to map the \\computer name\sharename (\\server\share) to the 
devicename (Z:). 

 

NOTE: For Windows 10 and Windows Server 2016, Microsoft improved network security 
with a change to the rules governing shared network drives/locations. 
More specifically, a shared network drive/location is now only accessible and 
visible to the user who created the shared network drive/location, even if the user is 
an Administrator. 

 

 

4.14 Problems installing VibroSight 3.7.x on computers without internet access 

On computers which are not connected to the internet, the VibroSight 3.7.x installer can experience problems when 
automatically installing the prerequisite Microsoft Visual C++ Redistributable Package for Visual Studio 2015, and 
report a generic message such as “Setup Failed. One or more issues caused the setup to fail”. 

As a workaround, trying to manual install the Microsoft Visual C++ Redistributable Package for Visual Studio 2015, 
the Microsoft Visual C++ installer can also experience problems, and report a similar generic “Setup Failed” 
message. 

This is a known Microsoft problem which is due to some components in Visual Studio being signed by a 
certification authority that is not installed on the computer, and the computer cannot automatically download the 
required certificate(s) because it is not connected to the internet. 

Accordingly, the Microsoft solution is to: 

1. On a computer which is connected to the internet, download the following certificate: 
http://www.microsoft.com/pki/certs/MicRooCerAut2011_2011_03_22.crt  
Then copy the certificate to the VibroSight computer (for example to C:\Temp). 

2. On the VibroSight computer, use the certmgr.exe utility to add the certificate by using the command line. 
Note: For more information, refer to the Certmgr.exe (Certificate Manager Tool) topic at MSDN. 

3. Open an admin command prompt and run the following command: 
certmgr.exe /add C:\Temp\MicRooCerAut2011_2011_03_22.cer /s /r localMachine root 

4.  Next, try installing the patch KB3135996 or KB3136000. 

 

If required, additional information is available from a Microsoft MSDN blog, here: 
https://blogs.msdn.microsoft.com/vsnetsetup/2016/03/28/a-certificate-chain-could-not-be-built-to-a-trusted-root-
authority-2 

  

https://docs.microsoft.com/en-us/sysinternals/downloads/psexec
https://blogs.msdn.microsoft.com/vsnetsetup/2016/03/28/a-certificate-chain-could-not-be-built-to-a-trusted-root-authority-2
https://blogs.msdn.microsoft.com/vsnetsetup/2016/03/28/a-certificate-chain-could-not-be-built-to-a-trusted-root-authority-2
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5 Compatibility 

As part of the VibroSight software installation process, the VibroSight installer will automatically check to see if the 
required Microsoft .NET Framework, Microsoft Visual C++ Redistributable Package, OPC Core Components 
Redistributable software and OPC UA Local Discovery Server are pre-installed on the computer: 

• The required Microsoft Visual C++ Redistributable Package (see section 5.1.3) must be manually installed 
before VibroSight can be installed. If it is not detected, then the VibroSight installer will exit the installation and 
VibroSight is not installed. 

• The required Microsoft .NET Framework (see section 5.1.2) is automatically installed by the VibroSight installer 
if it is not detected. 

• The required OPC Core Components Redistributable (see section 5.1.4) software is automatically installed on 
the computer by the VibroSight installer if it is not detected. 

• The required OPC UA Local Discovery Server (see section 5.1.5) software is automatically installed on the 
computer by the VibroSight installer if it is not detected. 

NOTE: Refer to the latest version of the  Getting started with VibroSight installation 

guide or the  VibroSight software data sheet for further information on 
VibroSight’s prerequisites and compatibility. 

 

 

5.1 VibroSight software 

VibroSight 5.1.0 is a minor level release and replaces VibroSight 5.0.x. 

Compatibility with existing VibroSight data repositories (databases) is achieved using a specific data migration 
process from any existing databases based on Sybase SQL Anywhere (*.vssrvdb) to data repositories based on 
the VibroSight historical data repositories (VibroSight historical data folder (*.vshdf) for operation with a 
VibroSight Server (live data) and VibroSight historical data archive (*.vshda) for operation with historical data). 

Compatibility with existing VibroSight machinery monitoring projects using VibroSight OPC Servers that were 
created using VibroSight 2.12.7 or earlier is achieved using a specific VibroSight OPC Server migration process for 
these VibroSight OPC Servers. 

Therefore, it is important to note that: 

• New machinery monitoring projects created with VibroSight 5.x.x (VibroSight 3.x.x or later) will automatically 
use VibroSight historical data repositories. 

• Existing machinery monitoring projects created with versions of VibroSight earlier than VibroSight 3.0.0 must 
be manually migrated from Sybase SQL Anywhere databases to VibroSight historical data repositories before 
they can be used with VibroSight 5.x.x (VibroSight 3.x.x or later). 

• Existing machinery monitoring projects using VibroSight OPC Servers that were created with versions of 
VibroSight earlier than VibroSight 2.12.7 must manually migrate their VibroSight OPC Servers before they can 
be used with VibroSight 5.x.x (VibroSight 3.x.x or later). 
It is very important to note that migrating a VibroSight OPC Server from VibroSight 2.12.7 or earlier to 
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VibroSight 5.x.x (VibroSight 3.x.x or later) or later requires that certain steps must be performed using the 
existing version of VibroSight (that is, VibroSight 2.12.7 or earlier) BEFORE it is removed (uninstalled). 

NOTE: The manual migration of an existing machinery monitoring project to 
VibroSight 5.x.x (VibroSight 3.x.x or later) or later is described in detail in the 
“Data migration” and “VibroSight OPC Server migration” sections of the latest  

 Getting started with VibroSight installation guide. 

 
 

5.1.1 Microsoft Windows operating systems 
VibroSight 5.x.x (VibroSight 3.x.x or later) or later is compatible with 32-bit versions and 64-bit versions of 
Microsoft ® Windows ® operating systems. 

NOTE: Starting with VibroSight 3.0.0, VibroSight software is now available as 64-bit 
software for 64-bit Windows and 32-bit software for 32-bit Windows. 
The 64-bit version of VibroSight can be installed on 64-bit Windows computers 
only. The 32-bit version of VibroSight can be installed on 32-bit Windows 
computers only. Only a single version of VibroSight can be installed and exist on a 
computer at any one time 

 
See the Appendix of these release notes for further information on VibroSight software and Windows operating 
system compatibility. 

 

 

5.1.2 Microsoft .NET Framework 
For most Windows operating systems, VibroSight 5.x.x (VibroSight 3.7.0 or later) requires that the Microsoft .NET 
Framework 4.7.2 or later is installed. 

NOTE: VibroSight 5.x.x requires Microsoft .NET Framework 4.7.2. 

 
If the required Microsoft .NET Framework is not pre-installed, then the VibroSight installer will detect this and 
automatically install it as part of the VibroSight software installation process. 

See the Appendix of these release notes for further information on VibroSight software and Microsoft .NET 
Framework requirements. 
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5.1.3 Microsoft Visual C++ Redistributable Package 
VibroSight 5.x.x (VibroSight 3.x.x or later) requires that the Microsoft Visual C++ Redistributable Package for Visual 
Studio 2015 is installed, in order to install and register the Visual C++ libraries used by VibroSight. 

NOTE: The 64-bit version of the Microsoft Visual C++ Redistributable Package (“Microsoft 
Visual C++ 2015 Redistributable (x64)”) must be installed on 64-bit Windows 
computers. 
The 32-bit version of the Microsoft Visual C++ Redistributable Package (“Microsoft 
Visual C++ 2015 Redistributable (x86)”) must be installed on 32-bit Windows 
computers. 

If the required Microsoft Visual C++ Redistributable Package is not pre-installed, then the VibroSight installer will 
detect this and exit the installation. 

 

 

5.1.4 OPC Core Components Redistributable 

VibroSight 5.x.x (VibroSight 3.x.x or later) requires that the OPC Core Components Redistributable is installed, in 
order to configure and run VibroSight OPC Clients and VibroSight OPC Servers correctly: the redistributable must 
be installed on OPC client computers in order to allow connections to remote OPC servers and it must be installed 
on OPC server computers in order to allow OPC clients to browse for running OPC servers. 

NOTE: The 64-bit version of the OPC Core Components Redistributable (“OPC Core 
Components Redistributable (x64) 106.0”) must be installed on 64-bit Windows 
computers. 

The 32-bit version of the OPC Core Components Redistributable (“OPC Core 
Components Redistributable (x86) 106.0”) must be installed on 32-bit Windows 
computers. 

 

If the required OPC Core Components Redistributable is not pre-installed, then the VibroSight installer will detect 
this and automatically install it as part of the VibroSight software installation. 

 

 

5.1.5 OPC UA Local Discovery Server  

VibroSight 5.x.x or later requires that the OPC UA Local Discovery Server is installed, in order to expose OPC UA 
servers for discovery and enable communications with OPC UA clients. 

If the required OPC UA Local Discovery Server is not pre-installed, then the VibroSight installer will detect this and 
automatically install it as part of the VibroSight software installation. 
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5.1.6 Sybase SQL Anywhere 11 software 

VibroSight 5.x.x (VibroSight 3.x.x or later) does not include any Sybase SQL database software. 

Starting with VibroSight 3.0.0, the VibroSight historical data repositories (VibroSight historical data folder 
(*.vshdf) for operation with a VibroSight Server (live data) and VibroSight historical data archive (*.vshda) for 
operation with historical data) are exclusively used for the required data repositories. 

A VibroSight database based on Sybase SQL Anywhere (*.vssrvdb) can no longer be used as a data repository. 
Accordingly, the Sybase SQL Anywhere 11 database software is no longer included and distributed as part of the 
VibroSight software. 

NOTE: VibroSight 3.x.x or later exclusively uses data repositories based on the VibroSight 
historical data system. 

VibroSight 2.12.7 used data repositories based on Sybase SQL Anywhere 
databases and introduced initial support for working with data repositories based 
on the VibroSight historical data repositories for data analysis. 

VibroSight 2.12.6 or earlier exclusively used data repositories based on Sybase 
SQL Anywhere databases. 

 

NOTE: The manual migration of an existing machinery monitoring project to 
VibroSight 5.x.x (VibroSight 3.x.x or later) is described in detail in the “Data 

migration” section of the latest  Getting started with VibroSight installation 
guide. 

 

 

5.1.7 Dell Backup and Recovery software 

Some Dell™ computers running versions of Dell Backup and Recovery software can experience problems running 
the VibroSight software, characterised by the VibroSight software not running or running incorrectly. This is 
because the Dell Backup and Recovery software can use a version of SQLite and associated libraries (DLLs) that 
prevent the VibroSight Host Service from running correctly. 

For example, VibroSight clients can stop running (crash), VibroSight clients can be unable to connect to data 
sources and/or VibroSight System manager may not display all of the commands expected to be available in the 
Actions window. 

If this behaviour is seen, the recommended workaround is to uninstall the Dell Backup and Recovery software. 

NOTE: It is recommended to install and use VibroSight 3.x.x or earlier on a computer that 
does not have Dell Backup and Recovery software installed. 
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5.1.8 MatrikonOPC software 

Both MatrikonOPC™ software and the VibroSight software can be installed and run on the same computer. 

However, if the MatrikonOPC software is installed after the VibroSight software, this can result in problems related 
to credentials (access rights). These problems are typically characterised by an unhandled exception in VibroSight 
Configurator when trying to configure an OPC device in the Hardware view or an unhandled exception in a 
VibroSight Server when trying to handle/process OPC data. 

MatrikonOPC software and the VibroSight software must be installed on the same computer in the following order: 

1. Install the MatrikonOPC software. 

2. Install the Microsoft Visual C++ Redistributable Package for Visual Studio 2010 (version 40219). 
Note: This redistributable package is required by the MatrikonOPC software. 

3. Install the Microsoft Visual C++ Redistributable Package for Visual Studio 2015 (version 23026 or later). 
Note: This redistributable package is required by the VibroSight software. 

4. Install VibroSight 3.x.x or later. 
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5.2 VM600 cards 

5.2.1 Card firmware 

There are some firmware upgrades for VM600 cards corresponding to VibroSight 5.1.0. 

 

The latest firmware for the CPUR2 card remains: 

• Base System: base-system-640-014-001-003.tgz 

• Applications: applications-640-015-001-003.tgz. 

 

The latest firmware for the CPUR card remains: 

• Base System: base-system-640-011-001-005.tgz 

• Applications: applications-640-012-001-005.tgz. 

 

NOTE: In order to help distinguish between VM600 CPUx cards, VibroSight 4.x.x or later 
uses the following terminology: 
• CPUR2 to refer to the latest version of the CPUx card with support for 
PROFIBUS (PNR 600-026-000-VVV). 
• CPUR to refer to the earlier version of the CPUx card with support for 
Modbus RTU/TCP and card pair redundancy (PNR 600-007-000-VVV). 

(Previously, VibroSight 2.12.7 to 3.8.x used CPUR to refer to the CPUx card with 
PROFIBUS but VibroSight 4.x.x or later refers to this card as the CPUR2.) 

 

The latest firmware for the MPC4G2 card is now: 

• 640-025-002-000.Mpc4g2Fw. 

See 2.4 MPC4G2/IOC4G2: development and evaluation. 

NOTE: VibroSight Protect / VM600 MPSG2 systems must not be used for “live” machinery 
protection system (MPS) applications until these products are officially released. 
Contact Meggitt SA for further information. 

 

The latest firmware for the XMC16, XMV16 and XMVS16 cards remains: 

• Base System: base-system-640-003-001-016.tgz 

• Applications: applications-640-010-001-016.tgz. 

 

Therefore, for current versions of VM600 cards, firmware upgrades are not required – except for 
VibroSight Protect / VM600 MPSG2 solutions. 
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5.3 VibroSmart devices 

5.3.1 Module firmware 

There are some firmware upgrades for VibroSmart modules and devices corresponding to VibroSight 5.1.0. 

 

The latest firmware for the VSI010 module remains: 

• 642-002-000-012.xmsifw. 

 

The latest firmware for the VSN010 device remains: 

• 642-004-000-011.redboxfw. 

 

The latest firmware for the VSV30x module is now: 

• 642-001-000-000DEV_SVN14937_2020-05-20.xtranfw. 

See 2.5 VSV30x/VSB300: hydro air-gap and magnetic-flux monitoring. 

 

Therefore, for current versions of VibroSmart modules and devices, a VSV30x firmware upgrade may be required, 
depending on the application. 
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6 Upgrade procedure 

This section describes the procedure for upgrading a VibroSight system from a previous version. Perform the steps 
in the given sequence in order to complete a system upgrade. 

NOTE: It is strongly recommended to verify the version of firmware running in the related 
hardware (XMx16 cards and VibroSmart modules and devices) before starting a 
VibroSight system upgrade, in order to establish if any firmware updates are also 
required. 
See 6.2.3 Updating the firmware using VibroSight System Manager. 

 

NOTE: It is strongly recommended to ensure that a copy of the configuration for a 
VibroSmart is available before updating the firmware of any of the VibroSmart 
modules used in the distributed monitoring system. See 6.2.3 Updating the 
firmware using VibroSight System Manager. 

 

 

6.1 VibroSight software user settings 

The VibroSight Software generates and uses some files on the storage device of the computer running VibroSight 
to keep track of user-configurable settings, so that these settings are remembered and applied for the VibroSight 
installation. 

These settings files have an .xmssettings file name extension and on a computer running Windows 7, can be 
found here: 

C:\Users\username\AppData\Roaming\Meggitt\VibroSight, where username is the Windows account name. 

For example, the VibroSightVision.xmssettings file records the user-configurable default settings for 
VibroSight Vision, such as default settings for plots. 

NOTE: VibroSight software updates and upgrades do not replace these settings files, so: 
• For a computer on which VibroSight was previously installed, an update, upgrade 
or a re-installation of VibroSight will continue to use the previous defaults recorded 
in the .xmssettings files. 
• For a computer on which VibroSight was not previously installed, the installation 
of VibroSight will generate and use new .xmssettings files, which use the latest 
VibroSight software defaults. 

If a settings file is deleted for any reason, VibroSight will generate and use a new 
settings file, which uses the latest VibroSight software defaults. 
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6.2 Updating VibroSight-compatible hardware 

Appropriate files and tools are included in the installation package to allow VM600 cards (XMx16) and VibroSmart 
devices (VSI010, VSN010 and VSV30x) to be updated to the latest firmware, in order to take advantage of 
improvements to the VibroSight software. 

Updating the firmware VM600 cards or VibroSmart devices is a special task that can, if used unintentionally or 
incorrectly, lead to malfunctioning of the device and affect proper function of data acquisition. 

During the firmware update of a device, the card or module being updated cannot provide its normal machinery 
monitoring functions because its outputs (alarms and relays) can go to undetermined states, irrespective of how 
they have been configured. 

For VibroSmart modules, the machinery being monitored is not protected for the duration of a firmware update and 
the restart (reboot) that is triggered automatically after the firmware update (which can take up to 5 minutes). 

NOTE: It is highly recommended that firmware updates are only performed in accordance 
with the operating procedures for the machinery being monitored and that 
appropriate precautions are taken at the control system level (such as DCS 
or PLC). 

For example, alarms and relay outputs should be ignored (bypassed or inhibited) in 
order to avoid false trips of the machinery being monitored. 

 

6.2.1 VM600 card firmware 

The latest VM600 card firmware files are copied to a directory on your computer as part of the VibroSight software 
installation process. 

NOTE: For example, the default firmware directory for VM600 cards is: 
C:\Program Files\Meggitt\VibroSight\Firmware\VM600 

 

The firmware files for a VM600 card can be found in the appropriate subfolder and identified by their .tgz file name 
extension. For example, the XMV16 subfolder contains the applications and base system firmware for use by 
XMV16 cards. Any additional firmware updates received from Meggitt SA should also be stored in these 
directories. 

Table 1 shows the compatibility between VibroSight software and VM600 CPUR2 card hardware (that is, 
CPUR2 firmware). 

Table 2 shows the compatibility between VibroSight software and VM600 CPUR card hardware (that is, 
CPUR firmware). 

Table 3 shows the compatibility between VibroSight software and VM600 MPC4G2 card hardware (that is, 
MPC4G2 firmware). 

Table 4 shows the compatibility between VibroSight software and VM600 XMx16 card hardware (that is, 
XMC16, XMV16 and XMVS16 firmware). 
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NOTE: It is strongly recommended to use the most recent version of the VM600 CPUR 
firmware and VM600 XMx16 firmware that is compatible with the version of 
VibroSight software being used. 
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Table 1: VibroSight software and VM600 CPUR2 firmware compatibility 

 VM600 CPUR2 firmware  See note 1 

VibroSight software version 

CD part number 

Base-system (*.tgz) 

640-014-001-001 640-014-001-002 640-014-001-003 

Applications (*.tgz) 

640-015-001-001 640-015-001-002 640-015-001-003 

3.1.0 
609-004-000-038 

 See note 2  See note 3  

3.2.0 
609-004-000-039 

   

3.3.0 
609-004-000-040 

   

3.4.0 
609-004-000-041 

   

3.5.0 
609-004-000-042 

   

3.6.0 
609-004-000-043 

   

3.7.0 
609-004-000-044 

   

3.8.0 
609-004-000-045 

   

4.0.0 
609-004-000-046 

   

4.1.0 
609-004-000-047 

   See note 4 

5.0.0 
609-004-000-048 

   

5.1.0 
609-004-000-049 

   

 

Notes for Table 1 (see the next page)  
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Notes for Table 1 
1. VM600 CPUR2 firmware is packaged and distributed as a .tgz file (a compressed archive file format) with PNRs such as 640-014-001-xxx for 
the Base System and 640-015-001-xxx for the (Applications) Firmware. In these PNRs, the xxx-xxx-001-xxx denotes the firmware is packaged 
in the tgz file format. 

After the .tgz file is unpacked by VibroSight System Manager and the firmware is uploaded to a VM600 CPUR2 card, the dialog box displayed 
by the VibroSight System Manager’s Change Firmware command shows the current version of firmware using PNRs such as 640-014-000-xxx 
for the Base System and 640-015-000-xxx for the Firmware, which correspond to the actual unpacked firmware that is running on the card. 

 

2. This is the first official release of VM600 CPUR2 firmware and includes features such as the management of XMx16 card configurations for 
applications such as control systems and the implementation of the PROFIBUS protocol for the fieldbus interfaces. A firmware upgrade is 
required in order to run VibroSight 2.12.7 or later. 

 

3. This version of VM600 CPUR2 firmware includes improvements such as changing the PROFIBUS polling rate for the Modbus server to 
100 ms (was 200 ms) and a bug fix for a known VM600 CPUx time counter wraparound (overflow) issue. A firmware upgrade is strongly 
recommended in order to run VibroSight 3.4.0 or later. 

 

4. This version of VM600 CPUR2 firmware includes improvements such as overall performance, responsiveness and stability, and support for 
CPUR2/IOCR2 card pair relays, and the ability to download the GSD file directly from the card. A firmware upgrade is strongly recommended 
but is not required in order to run VibroSight 4.1.0 or later. 
Note: VibroSight 4.1.0 or later must be used in order to download the VM600 CPUR2 GSD file directly from the CPUR2 card. 
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Table 2: VibroSight software and VM600 CPUR firmware compatibility 

 VM600 CPUR firmware  See note 1 

VibroSight software version 

CD part number 

Base-system (*.tgz) 

640-011-001-004 640-011-001-005 

Applications (*.tgz) 

640-012-001-004 640-012-001-005 

4.0.0 
609-004-000-046 

 See note 2  

4.1.0 
609-004-000-047 

  See note 3 

5.0.0 
609-004-000-048 

  

5.1.0 
609-004-000-049 

  

 

Notes for Table 2 
1. VM600 CPUR firmware is packaged and distributed as a .tgz file (a compressed archive file format) with PNRs such as 640-011-001-xxx for 
the Base System and 640-012-001-xxx for the (Applications) Firmware. In these PNRs, the xxx-xxx-001-xxx denotes the firmware is packaged 
in the tgz file format. 

After the .tgz file is unpacked by VibroSight System Manager and the firmware is uploaded to a VM600 CPUR card, the dialog box displayed by 
the VibroSight System Manager’s Change Firmware command shows the current version of firmware using PNRs such as 640-011-000-xxx for 
the Base System and 640-012-000-xxx for the Firmware, which correspond to the actual unpacked firmware that is running on the card. 

 

2. This is the latest official release of VM600 CPUR firmware (that is, the earlier version of the CPUx card with support for card pair redundancy 
(PNR 600-007-000-VVV)), which was discontinued in VibroSight 2.12.0 and reintroduced in VibroSight 4.0.x). 

 

3. This version of VM600 CPUR firmware includes a bug fix for a known VM600 CPUx time counter wraparound (overflow) issue and the 
addition of relay outputs to the diagnostics logs. A firmware upgrade is strongly recommended but is not required in order to run VibroSight 4.1.0 
or later. 
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Table 3: VibroSight software and VM600 MPC4G2 firmware compatibility 

 
VM600 MPC4G2 firmware 

(*.Mpc4g2Fw) 

VibroSight software version 

CD part number 
640-025-001-000 640-025-002-000 

5.0.0 
609-004-000-048 

 See note 1  

5.1.0 
609-004-000-049 

  See note 2 

 

Notes for Table 3 
1. This version of VM600 MPC4G2 firmware is a release intended to support the development and evaluation of VibroSight Protect and 
VM600 MPSG2 systems only. 

 

2. This version of VM600 MPC4G2 firmware is a release intended to support the ongoing development and evaluation of VibroSight Protect and 
VM600 MPSG2 systems only. A firmware upgrade is required in order to run VibroSight 5.1.0 or later. 

 

NOTE: VibroSight Protect / VM600 MPSG2 systems must not be used for “live” machinery protection 

system (MPS) applications until these products are officially released. 

Contact Meggitt SA for further information. 
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Table 4: VibroSight software and VM600 XMx16 firmware compatibility 

 VM600 XMx16 firmware  See note 1 

VibroSight software version 

CD part number 

Base-system (*.tgz) 

640-003- 
001-014 

640-003- 
001-016 

Applications (*.tgz) 

640-010- 
001-014 

640-010- 
001-016 

3.1.0 
609-004-000-038 

 See note 2  

3.2.0 
609-004-000-039 

  

3.3.0 
609-004-000-040 

  See note 3 

3.4.0 
609-004-000-041 

  

3.5.0 
609-004-000-042 

  

3.6.0 
609-004-000-043 

  

3.7.0 
609-004-000-044 

  

3.8.0 
609-004-000-045 

  

4.0.0 
609-004-000-046 

  

4.1.0 
609-004-000-047 

  

5.0.0 
609-004-000-048 

  

5.1.0 
609-004-000-049 

  

 

Notes for Table 4 (see the next page)  
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Notes for Table 4 
1. VM600 XMx16 firmware is packaged and distributed as a .tgz file (a compressed archive file format) with PNRs such as 640-003-001-xxx for 
the Base System and 640-010-001-xxx for the (Applications) Firmware. In these PNRs, the xxx-xxx-001-xxx denotes the firmware is packaged 
in the tgz file format. 

After the .tgz file is unpacked by VibroSight System Manager and the firmware is uploaded to a VM600 XMx16 card, the dialog box displayed by 
the VibroSight System Manager’s Change Firmware command shows the current version of firmware using PNRs such as 640-010-000-xxx for 
the Firmware and 640-003-000-xxx for the Base System, which correspond to the actual unpacked firmware that is running on the card. 

 

2. This version of VM600 XMx16 firmware adds support for customer-specific functionality that is enabled by a customer-specific VibroSight 
software license. A firmware upgrade is required in order to run VibroSight 3.0.0 or later. 

 

3. This version of VM600 XMx16 firmware includes relaxed constraints for dynamic data retention time, that is, optimised memory to reduce the 
possibility of missing data in data intensive VibroSight applications running on less powerful computers. A firmware upgrade is required in order 
to run VibroSight 3.3.0 or later. 
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6.2.2 VibroSmart device firmware 

The latest VibroSmart device firmware files are copied to a directory on your computer as part of the VibroSight 
software installation process. 

NOTE: The default firmware directory for VibroSmart devices is: 
C:\Program Files\Meggitt\VibroSight\Firmware\VibroSmart 

 

The firmware files for a VibroSmart device can be found in the appropriate subfolder and identified by their .*fw file 
name extension. For example, the VSV30x subfolder contains the firmware for use by VSV30x modules. Any 
additional firmware updates received from Meggitt SA should also be stored in these directories. 

Table 5 shows the compatibility between VibroSight software and the VibroSmart VSI010 firmware. 

Table 6 shows the compatibility between VibroSight software and the VibroSmart VSN010 firmware. 

Table 7 shows the compatibility between VibroSight software and the VibroSmart VSV30x firmware. 

 

NOTE: It is strongly recommended to use the most recent version of the VibroSmart 
firmware that is compatible with the version of VibroSight software being used. 
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Table 5: VibroSight software and VibroSmart VSI010 firmware compatibility 

 VSI010 firmware (*.xmsifw)  See note 1 

VibroSight software version 
CD part number 

642-002-000-009 642-002-000-010 642-002-000-011 642-002-000-012 

3.1.0 
609-004-000-038 

 See note 2 
See notes 

2 and 3 
 

 

3.2.0 
609-004-000-039 

   
 

3.3.0 
609-004-000-040 

   
 

3.4.0 
609-004-000-041 

   
 

3.5.0 
609-004-000-042 

   
 

3.6.0 
609-004-000-043 

   
 

3.7.0 
609-004-000-044 

   
 

3.8.0 
609-004-000-045 

   
 

4.0.0 
609-004-000-046 

   
 

4.1.0 
609-004-000-047 

   
 

5.0.0 
609-004-000-048 

  
See notes 

2 and 4 

See notes 

2 and 5 

5.1.0 
609-004-000-049 

    

 

Notes for Table 5 (see the next page)  
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Notes for Table 5 
1. VibroSmart VSI010 firmware is distributed as a single .xmsifw file (a proprietary file format) with a PNR such as 642-xxx-000-xxx. In these 
PNRs, the xxx-xxx-000-xxx denotes that the firmware is not packaged (compressed or archived). VibroSight System Manager always uses and 
displays information about VibroSmart device firmware using PNRs such as 642-xxx-000-xxx, which correspond to the actual firmware that is 
running on the device. 
 
2. Updating to this version of VibroSmart VSI010 firmware requires a specific process: 

Notes: 

For a VibroSmart consisting of different types of device, the devices should be updated in the following order: first VSN010 real-time Ethernet 
switches, then VSV30x vibration monitoring modules and finally VSI010 communications interface modules. In addition, VibroSight System 
Manager should be exited (closed) and restarted after updating the firmware for each type of device, before continuing. And after updating the 
firmware, the configuration on the VibroSmart devices should be re-applied (re-activated) and the VibroSmart devices should be restarted. 

Procedure: 

(1) Ensure that a copy of the configuration for the VibroSmart is available before updating any device firmware. For example, using the currently 
installed version of VibroSight (that is, before any updates to the VibroSight software corresponding to updates to VibroSmart devices), 
VibroSight Configurator can be used to obtain a copy of the configuration as follows: 
• For a VibroSmart using a VibroSight Server, the File > Open > Server / Database command can be used to read the configuration from the 
VibroSight Server. 
• For a VibroSmart not using a VibroSight Server (that is, a “stand-alone” VibroSmart), the File > Open > Device command can be used to read 
the configuration directly from the VibroSmart modules. 
Then the File > Save As > File command can be used to store a copy of the configuration for the VibroSmart. 

(2) Start VibroSight System Manager, select the device or devices of the same type to be updated (for example, VSI010 modules) and run the 
Change Firmware command. 
When updating multiple VibroSmart devices of the same type to use the same firmware, CTRL+click or SHIFT+click can be used to select 
multiple devices in the Devices tree structure of the System Explorer window. This way, when the Change Firmware command is run, all of 
devices that were selected will be updated at the same time. Otherwise, each device must be selected and updated individually. 

(3) When the VibroSmart Module(s) Firmware Upgrade window displays a “Firmware upgrade terminated. The firmware has been upgraded 
successfully …” message, click the Finish button to continue. 
If after 10 minutes, the VibroSmart Module(s) Firmware Upgrade window does not display a successful message, click the Cancel button to 
close the window and continue. 
Then exit (close) VibroSight System Manager. 

(4) Restart VibroSight System Manager and verify that the correct version of firmware is reported for each device that was updated. (When a 
device is selected in the System Explorer window, this information is available in the main window (centre) under Module PNR. It is also 
available in the VibroSmart Module(s) Firmware Upgrade window when a device is selected and the Change Firmware command is run). 
If a device does not report the correct version of firmware, rerun the Change Firmware command for this device. 
Then exit (close) VibroSight System Manager. 

(5) Repeat steps (2), (3) and (4) for each type of device to be updated (for example, VSN010 and VSV30x modules). 

(6) Start VibroSight Configurator, open the configuration for the VibroSmart (see step (1)), then apply (activate) the configuration. (If required, 
VibroSight Configurator will automatically update the configuration to the latest version and inform the user.) 
Then exit (close) VibroSight Configurator. 

(7) Turn the power supply to the VibroSmart off and wait for a few seconds. Then turn the power supply back on and verify that the system 
operates as expected. 

During this firmware update process, the behaviour of the LEDs on the front panel of the VibroSmart devices can be inconsistent and should be 
ignored. Normal LED behaviour resumes after the firmware update is complete (after step (7)). 
 
3. This version of VibroSmart VSI010 firmware has no limit on the number of constants per VSI010 module. 
A firmware upgrade is recommended but is not required in order to run VibroSight 3.8.0 or later. 
 
4. This version of VibroSmart VSI010 firmware adds support for Modbus function code 03. A firmware upgrade is required in order to run 
VibroSight 5.0.0 or later. 
 
5. This version of VibroSmart VSI010 firmware adds support for module lock and the GOOSE communications protocol (IEC 61850). 
A firmware upgrade is required in order to run VibroSight 5.0.0 or later. 
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Table 6: VibroSight software and VibroSmart VSN010 firmware compatibility 

 VSN010 firmware (*.redboxfw)  See note 1 

VibroSight software version 
CD part number 

642-004-000-011 

3.1.0 
609-004-000-038 

 See note 2 

3.2.0 
609-004-000-039 

 

3.3.0 
609-004-000-040 

 

3.4.0 
609-004-000-041 

 

3.5.0 
609-004-000-042 

 

3.6.0 
609-004-000-043 

 

3.7.0 
609-004-000-044 

 

3.8.0 
609-004-000-045 

 

4.0.0 
609-004-000-046 

 

4.1.0 
609-004-000-047 

 

5.0.0 
609-004-000-048 

 

5.1.0 
609-004-000-049 

 

 

Notes for Table 6 (see the next page)  
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Notes for Table 6 
1. VibroSmart VSN010 firmware is distributed as a single .redboxfw file (a proprietary file format) with a PNR such as 642-xxx-000-xxx. In these 
PNRs, the xxx-xxx-000-xxx denotes that the firmware is not packaged (compressed or archived). VibroSight System Manager always uses and 
displays information about VibroSmart device firmware using PNRs such as 642-xxx-000-xxx, which correspond to the actual firmware that is 
running on the device. 

 

2. Updating to this version of VibroSmart VSN010 firmware requires a specific process: 

Notes: 

For a VibroSmart consisting of different types of device, the devices should be updated in the following order: first VSN010 real-time Ethernet 
switches, then VSV30x vibration monitoring modules and finally VSI010 communications interface modules. In addition, VibroSight System 
Manager should be exited (closed) and restarted after updating the firmware for each type of device, before continuing. And after updating the 
firmware, the configuration on the VibroSmart devices should be re-applied (re-activated) and the VibroSmart devices should be restarted. 

Procedure: 

(1) Ensure that a copy of the configuration for the VibroSmart is available before updating any device firmware. For example, using the currently 
installed version of VibroSight (that is, before any updates to the VibroSight software corresponding to updates to VibroSmart devices), 
VibroSight Configurator can be used to obtain a copy of the configuration as follows: 
• For a VibroSmart using a VibroSight Server, the File > Open > Server / Database command can be used to read the configuration from the 
VibroSight Server. 
• For a VibroSmart not using a VibroSight Server (that is, a “stand-alone” VibroSmart), the File > Open > Device command can be used to read 
the configuration directly from the VibroSmart modules. 
Then the File > Save As > File command can be used to store a copy of the configuration for the VibroSmart. 

 (2) Start VibroSight System Manager, select the device or devices of the same type to be updated (for example, VSN010 modules) and run the 
Change Firmware command. 
When updating multiple VibroSmart devices of the same type to use the same firmware, CTRL+click or SHIFT+click can be used to select 
multiple devices in the Devices tree structure of the System Explorer window. This way, when the Change Firmware command is run, all of 
devices that were selected will be updated at the same time. Otherwise, each device must be selected and updated individually. 

(3) When the VibroSmart Module(s) Firmware Upgrade window displays a “Firmware upgrade terminated. The firmware has been upgraded 
successfully …” message, click the Finish button to continue. 
If after 10 minutes, the VibroSmart Module(s) Firmware Upgrade window does not display a successful message, click the Cancel button to 
close the window and continue. 
Then exit (close) VibroSight System Manager. 

(4) Restart VibroSight System Manager and verify that the correct version of firmware is reported for each device that was updated. (When a 
device is selected in the System Explorer window, this information is available in the main window (centre) under Module PNR. It is also 
available in the VibroSmart Module(s) Firmware Upgrade window when a device is selected and the Change Firmware command is run). 
If a device does not report the correct version of firmware, rerun the Change Firmware command for this device. 
Then exit (close) VibroSight System Manager. 

(5) Repeat steps (2), (3) and (4) for each type of device to be updated (for example, VSI010 and VSV30x modules). 

(6) Start VibroSight Configurator, open the configuration for the VibroSmart (see step (1)), then apply (activate) the configuration. (If required, 
VibroSight Configurator will automatically update the configuration to the latest version and inform the user.) 
Then exit (close) VibroSight Configurator. 

(7) Turn the power supply to the VibroSmart off and wait for a few seconds. Then turn the power supply back on and verify that the system 
operates as expected. 

During this firmware update process, the behaviour of the LEDs on the front panel of the VibroSmart devices can be inconsistent and should be 
ignored. Normal LED behaviour resumes after the firmware update is complete (after step (7)). 
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Table 7: VibroSight software and VibroSmart VSV30x firmware compatibility 

 VSV30x firmware (*.xtranfw)  See note 1 

VibroSight 
software version 
CD part number 

642-001-000-015 642-001-000-016 642-001-000-017 642-001-000-018 

642-001-000- 
000DEV_ 

SVN14937_ 
2020-05-20 

3.4.0 
609-004-000-041 

See notes 

2 and 3 

See notes 

2 and 4 

   

3.5.0 
609-004-000-042 

  
   

3.6.0 
609-004-000-043 

  
   

3.7.0 
609-004-000-044 

  
   

3.8.0 
609-004-000-045 

  
   

4.0.0 
609-004-000-046 

  
   

4.1.0 
609-004-000-047 

  
   

5.0.0 
609-004-000-048 

  
See notes 

2 and 5 

See notes 

2 and 6 

 

5.1.0 
609-004-000-049 

    
See notes 

2 and 7 
 

Notes for Table 7 (see the next page)  
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Notes for Table 7 
1. VibroSmart VSV30x firmware is distributed as a single .xtranfw file (a proprietary file format) with a PNR such as 642-xxx-000-xxx. In these 
PNRs, the xxx-xxx-000-xxx denotes that the firmware is not packaged (compressed or archived). VibroSight System Manager always uses and 
displays information about VibroSmart device firmware using PNRs such as 642-xxx-000-xxx, which correspond to the actual firmware that is 
running on the device. 
 

2. Updating to this version of VibroSmart VSV30x firmware requires a specific process: 

Notes: 

For a VibroSmart consisting of different types of device, the devices should be updated in the following order: first VSN010 real-time Ethernet 
switches, then VSV30x vibration monitoring modules and finally VSI010 communications interface modules. In addition, VibroSight System 
Manager should be exited (closed) and restarted after updating the firmware for each type of device, before continuing. And after updating the 
firmware, the configuration on the VibroSmart devices should be re-applied (re-activated) and the VibroSmart devices should be restarted. 

Procedure: 

(1) Ensure that a copy of the configuration for the VibroSmart is available before updating any device firmware. For example, using the currently 
installed version of VibroSight (that is, before any updates to the VibroSight software corresponding to updates to VibroSmart devices), 
VibroSight Configurator can be used to obtain a copy of the configuration as follows: 
• For a VibroSmart using a VibroSight Server, the File > Open > Server / Database command can be used to read the configuration from the 
VibroSight Server. 
• For a VibroSmart not using a VibroSight Server (that is, a “stand-alone” VibroSmart), the File > Open > Device command can be used to read 
the configuration directly from the VibroSmart modules. 
Then the File > Save As > File command can be used to store a copy of the configuration for the VibroSmart. 
(2) Start VibroSight System Manager, select the device or devices of the same type to be updated (for example, VSV30x modules) and run the 
Change Firmware command. 
When updating multiple VibroSmart devices of the same type to use the same firmware, CTRL+click or SHIFT+click can be used to select 
multiple devices in the Devices tree structure of the System Explorer window. This way, when the Change Firmware command is run, all of 
devices that were selected will be updated at the same time. Otherwise, each device must be selected and updated individually. 
(3) When the VibroSmart Module(s) Firmware Upgrade window displays a “Firmware upgrade terminated. The firmware has been upgraded 
successfully …” message, click the Finish button to continue. 
If after 10 minutes, the VibroSmart Module(s) Firmware Upgrade window does not display a successful message, click the Cancel button to 
close the window and continue. 
Then exit (close) VibroSight System Manager. 
(4) Restart VibroSight System Manager and verify that the correct version of firmware is reported for each device that was updated. (When a 
device is selected in the System Explorer window, this information is available in the main window (centre) under Module PNR. It is also 
available in the VibroSmart Module(s) Firmware Upgrade window when a device is selected and the Change Firmware command is run). 
If a device does not report the correct version of firmware, rerun the Change Firmware command for this device. 
Then exit (close) VibroSight System Manager. 
(5) Repeat steps (2), (3) and (4) for each type of device to be updated (for example, VSI010 and VSN010 modules). 
(6) Start VibroSight Configurator, open the configuration for the VibroSmart (see step (1)), then apply (activate) the configuration. (If required, 
VibroSight Configurator will automatically update the configuration to the latest version and inform the user.) 
Then exit (close) VibroSight Configurator. 
(7) Turn the power supply to the VibroSmart off and wait for a few seconds. Then turn the power supply back on and verify that the system 
operates as expected. 
During this firmware update process, the behaviour of the LEDs on the front panel of the VibroSmart devices can be inconsistent and should be 
ignored. Normal LED behaviour resumes after the firmware update is complete (after step (7)). 
 

3. This version of VibroSmart VSV30x firmware adds support for hydro air-gap monitoring. 
A firmware upgrade is required in order to run VibroSight 3.4.0 or later. 
 

4. This version of VibroSmart VSV30x firmware adds support for latched alarms. 
A firmware upgrade is recommended but is not required in order to run VibroSight 3.6.0 or later. 
 

5. This version of VibroSmart VSV30x firmware adds support for configurable tacho ratios, flexible input channel to processing block mapping, 
and up to two tacho processing blocks. A firmware upgrade is required in order to run VibroSight 5.0.0 or later. 
 
6. This version of VibroSmart VSV30x firmware adds support for module lock, PTP (precision time protocol) time synchronisation, channel 
bypass and pre-trigger data logging. A firmware upgrade is required in order to run VibroSight 5.0.0 or later. 
 

7. This version of VibroSmart VSV30x firmware improves support for hydro air-gap and magnetic-flux monitoring with a minor bug fix. 
A firmware upgrade is required in order to run VibroSight 5.1.0 or later.  
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6.2.3 Updating the firmware using VibroSight System Manager 

When performing VibroSight software upgrades, it is strongly recommended to systematically upgrade the firmware 
of VM600 XMx16 cards and VibroSmart devices to the latest compatible version. 

Failure to perform a necessary VibroSight-compatible VM600 card firmware update may lead to incoherent system 
behaviour and affect the proper functioning of data acquisition in a system. It is only in systems where the firmware 
running on the XMx16 cards and VibroSmart devices already corresponds to the latest available version that no 
firmware update is required. Therefore, it is strongly recommended to verify the version of firmware running on the 
hardware before starting a VibroSight system upgrade, in order to establish if a firmware update is also required. 

NOTE: Changing the firmware of the VibroSight hardware is a special administrative task 
that can – if performed unintentionally – affect the proper functioning of data 
acquisition in a system. 

It is therefore strongly recommended to change the firmware of the VibroSight 
hardware only when it is necessary. For example, when the devices must be 
updated to be compatible with a VibroSight software upgrade. 

 

For VibroSmart modules, each module can be selected and its firmware updated individually. Alternatively, multiple 
modules of the same type (for example, VSV3x0) can be updated to the same version of firmware at the same 
time. 

NOTE: It is strongly recommended to ensure that a copy of the configuration for a 
VibroSmart is available before updating the firmware of any of the VibroSmart 
modules used in the distributed monitoring system. 

For example, using the currently installed version of VibroSight (that is, before any 
updates to the VibroSight software corresponding to updates to VibroSmart 
modules), VibroSight Configurator should be used to obtain a copy of the 
configuration as follows:  

For a VibroSmart using a VibroSight Server, the File > Open > Server / Database 
command can be used to read the configuration from the VibroSight Server. 

For a VibroSmart not using a VibroSight Server (that is, a “stand-alone” 
VibroSmart), the File > Open > Device command can be used to read the 
configuration directly from the VibroSmart modules. 

Then the File > Save As > File command should be used to store a copy of the 
configuration for the VibroSmart distributed monitoring system. 

 

Update the firmware on a VibroSight device using the  Change Firmware tool (from VibroSight System 
Manager’s Maintenance tools): 

1. Ensure that the computer running the VibroSight software is on the same network as the hardware (XMx16 
card or VibroSmart module or device) to be updated. 

2. Start VibroSight System Manager and navigate to the Devices tree structure in the System Explorer window. 
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The Devices tree lists all of the VibroSight compatible hardware that VibroSight can see on the network. If 
there are no XMx16 cards or VibroSmart devices in the tree structure or some cards are missing, verify your 
network connections. 

3. Select the card or device that requires its firmware to be changed. 

The Actions tool window updates to show the available tools. 

To change multiple VibroSmart to use the same version of firmware at the same time, use CTRL+click or 
SHIFT+click to select multiple devices from the Devices tree-view. (Then, when the Change Firmware 
command is run, all of the devices that were selected will be updated at the same time.) 

4. Click  Change Firmware in the Maintenance tools group of the Actions window. 

The Change Firmware dialog box appears. 

5. Click the Add button and select the new firmware files for the card or new firmware file for the device. 

 NOTE: The Change Firmware dialog box automatically opens the firmware folder 
corresponding to the VibroSight-compatible VM600 card or VibroSmart device 
selected. 

.tgz files are for VM600 cards and .*fw files are for VibroSmart devices. 

 

6. Click the Finish button to start the firmware upgrade process. 

For XMx16 cards and VibroSmart devices, the firmware upgrade process can take up to 5 minutes, during 
which: 

• The IP address beside the device’s serial number in the Devices tree structure can disappear. 

• The LEDs on the front panel of the device can change to reflect the status of the upgrade. 

7. Repeat steps 3 to 6 for each device that requires a firmware update. 

 NOTE: Although the firmware for each VibroSight device must be changed individually 

using the  Change Firmware tool, as each device updates its firmware 
independently of the VibroSight software (once the process has started), firmware 
updates can be performed on several devices in parallel. 

 

8. After the firmware upgrade, verify that the VibroSight system is acquiring data from the cards. 

 NOTE: Refer also to the Changing the firmware topics in the  VibroSight help. 

 

The  Change Firmware tool can be used to load a VibroSight device with any version of firmware. It is 
therefore possible to change a device’s firmware to any previously available version, as well as the latest update. 
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This feature can be useful in certain situations, for example, swapping spare VibroSight hardware between different 
VM600 racks or VibroSmart distributed monitoring systems, where systems are operating with different versions of 
VibroSight. 

 

6.3 Final checks 

After upgrading the VibroSight software, it is recommended to check that VibroSight has not been inadvertently 
modified and that it continues to operate normally. 

 

In particular, it is recommended to check any VibroSight Servers in order to ensure that the data acquisition and 
external interfaces, data post-processing and/or logging are all configured as expected. 

 

In a VibroSight Server user interface: 

• On the Status tab under Device drivers, check that the VM600, VibroSmart, OPC and Modbus controls are 
enabled or disabled as required by your application. 

• On the Status tab under Server features, check that the Basic math, Air gap, Combustion monitoring, Duration 
counters, VSHDA import and Data logging manager controls are enabled or disabled as required by your 
application. 

• On the Log messages tab, check the listed messages (Info level) to ensure that the hardware (VM600 cards 
and /or VibroSmart modules) have been discovered and that data acquisition has resumed. 

NOTE: When a VibroSight Server is running as a Windows service, the usual VibroSight 
Server user interface is not displayed, so VibroSight System Manager must be 
used to work with the VibroSight Server. 

That is, VibroSight System Manager can be used to connect to a VibroSight Server 
in order to check and configure the operation of the server’s drivers and features. 

 

 

Finally, after an upgrade, it is strongly recommended to use VibroSight Vision to connect to any VibroSight Servers 
in order to verify that new live and/or historical data is available. 
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7 Customer support 

7.1 Contacting us 

Meggitt SA worldwide customer support network offers a range of support including Technical support and Sales 
and repairs support. For customer support, please contact your local Meggitt representative. Alternatively, contact 
our main office: 

Customer support  
Meggitt SA 

Route de Moncor 4 
PO Box 1616 

CH-1701 Fribourg 
Switzerland 

 

Telephone: +41 (0) 26 407 11 11 
Email: energysupport@ch.meggitt.com 

Website: www.meggittsensing.com/energy 

 

7.2 Technical support 

Meggitt SA technical support team provide both pre-sales and post-sales technical support, including: 

• General advice 

• Technical advice 

• Troubleshooting 

• Site visits. 

 

7.3 Sales and repairs support 

Meggitt SA sales team provide both pre-sales and post-sales support, including advice on: 

• New products 

• Spare parts 

• Repairs. 

 

 

mailto:energysupport@ch.meggitt.com
http://www.meggittsensing.com/energy
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Appendix 
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VibroSight software and Windows operating system compatibility 

 

 
Windows 10 Windows 8.1 Windows 7 

VibroSight software compatible? Yes Yes 

Yes 
(but not recommended for new 

installations as Microsoft support for 
Windows 7 ended in 

January 2020) 

 

 

VibroSight software and Windows Server operating system compatibility 

 

 
Windows Server 2016 Windows Server 2012 Windows Server 2008 R2 

VibroSight software compatible? Yes Yes 

Yes 
(but not recommended for new 

installations as Microsoft support for 
Windows Server 2008 R2 ended in 

January 2020) 
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VibroSight software and Microsoft .NET Framework requirements 

VibroSight software version Microsoft .NET Framework requirements 

VibroSight 3.7.0 or later .NET Framework 4.7.2 See note 1 

VibroSight 3.4.0 or later .NET Framework 4.7.1 See note 2 

VibroSight 3.0.0 or later .NET Framework 4.6 

VibroSight 2.12.0 or later .NET Framework 4.5 and .NET Framework 2.0 See note 3 

VibroSight 2.9.4 or later .NET Framework 4.5 

VibroSight 2.9.3 and 2.9.2 .NET Framework 4 (Standalone Installer) 

VibroSight 2.9.1 or earlier .NET Framework 3.5 SP1 
 

Notes 

1. Microsoft .NET Framework 4.7.2 replaces .NET Framework versions 4.0 to 4.7.1. 

2. Microsoft .NET Framework 4.7.1 replaces .NET Framework versions 4.0 to 4.7. 

3. Since Microsoft .NET Framework 3.5 also includes .NET Framework 2.0 and .NET Framework 3.0, installing Microsoft .NET Framework 3.5 SP1 is the recommended solution for most computers (rather than 

installing Microsoft .NET Framework 2.0). 
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